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1. 
Introduction

This document is the user guide for Release 3 of the Swift version of  TAKO. TAKO (Timeline Assembler, Keyword Oriented) is a GOTS suite of software initially developed by a group in the Laboratory for High Energy Astrophysics at the Goddard Space Flight Center for scheduling spacecraft science observations.  It was adapted and modified for use on the Swift mission. 

In this section, we describe scheduling concepts and terminology that may be unique to TAKO or to the Swift mission.  The second section describes how to bring up the application and details the contents of the input and output files. The next section walks through a typical daily scheduling session and tells how to use TAKO to do the various tasks.  The final section describes the features of the user interface. 

1.1 
Context

The purpose of TAKO is to take a candidate observation list and produce an observation schedule.  The observations are scheduled so that safety constraints are not violated, and all of the available time is filled with the higher priority targets.  The resulting schedule contains a time-tagged list of preplanned target (PPT) pointings (or snapshots) which is called the preplanned science timeline (PPST).  Figure 1.1 illustrates the observation commanding process at a high level. 
The PPST file is input to the mission planning system (MPS) which creates the stored command load.  For each snapshot in the schedule, the load contains an FOPPTREQUEST command that requests an observation of the target.  Finally, the stored command load is uplinked to the spacecraft where each FOPPTREQUEST command is executed at the scheduled time.  (What the FOM actually does with the FOPPTREQUEST command when it receives it is described in another document.)

The telemetry contains data about the targets that were actually observed.  The Timeline Monitor process in the MOC produces an As-Flown Timeline and a Time on Target Report.   The Time on Target Report lists the planned targets and their expected observation times based on the PPST along with the actual observation time based on telemetry.  This report is updated each pass.  This report can assist the science planner in planning future observing schedules.


[image: image3.emf]
Figure 1.1.
 Simple Observation Commanding Flow

1.2
 TAKO Concepts and Terminology

The user interacts with TAKO through a graphical user interface. The diagram in Figure 1.2-1 illustrates the components of TAKO that the user will be aware of.


[image: image4.emf]
Figure 1.2-1.
 TAKO Data and Control Flow Diagram

The user inputs the observation list (also called "target list") that the scheduler uses.  The observation list is a set of observation segment definitions created and modified in the Target Database Editor function. An observation segment definition contains parameters that define the target, spacecraft roll, and instrument modes.  A target is a distinct location in the sky defined by a right ascension and declination (RA/Dec) pair. Each target is identified by a unique 24-bit target identification number provided to TAKO by the user. The user must also assign a unique 8-bit segment number for each new observation of a target.  The target ID and the segment number are combined to form the observation number.  Each observation segment definition is identified by a unique observation number.  Refer to SWIFT Observation Definition Memorandum, 410.4-AGMT-0011, for details. An observation segment definition also includes guidelines for the scheduler, including the length of time the target should be observed and the priority of the segment.  

The main panel of the TAKO user interface, shown in Figure 1.2-2, contains the schedule timeline, the target viewer, and a status message display. The schedule timeline shows parallel plots of the currently scheduled target snapshots, the constraint curves, and other scheduling information.  A snapshot is a portion of an observation that can be made while observation constraints are not violated and while other higher priority targets are not scheduled. The period during which none of the observation constraints are violated is called a "goodtime" period.  The scheduler will create several snapshots  to complete an observation segment. An observation segment is considered complete after a series of scheduled snapshots accumulates the desired amount of time on the target. 

The schedule timeline will plot snapshots that are within the current scheduling period.  The scheduling period contains two sections: the reference period (shaded box) and the window of interest. You cannot unschedule or schedule snapshots during the reference period since it is outside of the window of interest.  It's just there to provide continuity. The window of interest is the range of time in which the schedule can be changed and it is the range of time that the preplanned science timeline (PPST) will be generated from.  The scheduling period and window of interest time ranges are saved in the target database.

The constraint curves are computed using the current ephemeris file and the constraint definitions. The constraint definitions are read from the current target database.  The constraint parameters can be changed by the user, if necessary, using the Target Database Editor.


[image: image5.emf]
Figure 1.2-2.
 TAKO Main Display

The target viewer is a tabular list of the observations in the target database.  The user selects an observation from the target viewer, then TAKO plots the constraint values specific to that observation.  The status message display, called Info box by TAKO, shows time-stamped messages that indicate the progress of TAKO's processing.  These messages are also stored in a log file.

The TAKO supports both interactive and automated scheduling of observations.  Interactive scheduling allows the user to select a target from the list and click on the timeline at the desired starting point of the observation.  Individual snapshots are placed by the scheduler during "goodtime" periods that are not occupied by other target's snapshots.   The automated scheduling function (or autoscheduling) schedules many observations by choosing the starting time automatically based on user-supplied guidelines. Use of autoscheduling is recommended so that the snapshots can be placed as closely together as possible. The user can combine interactive and autoscheduling by manually placing a few targets and then autoscheduling the remainder.  

Although the autoscheduler has user-supplied parameters, the recommended parameter values for Swift are to schedule all the targets shown in the Target Viewer starting at the beginning of the window of interest, and that observations with high priority values are scheduled first. The autoscheduler creates a list of unscheduled or partially scheduled observations.  Any completely scheduled observation as well as any "manually" scheduled observation is not included in this list; they remain unchanged by the autoscheduler.  The autoscheduler attempts to schedule the highest priority observation at the first available "goodtime" that is not occupied by another observation.  The entire observation is scheduled before going on to the next highest priority observation. The process is repeated until it schedules all the observations that can be scheduled within the window of interest.  Sometimes the observation can only be partially scheduled.  The autoscheduler schedules as many snapshots for an observation as it can within the window of interest, and the remainder of the observation time will be scheduled during the next day's session.  (The legacy version of TAKO would not partially schedule an observation.)

A target database can be in one of three schedule states: Working, Alternate, and Approved. You will normally start the scheduling session with the most recent Approved database, then update the time range and save the file under a different name as a new Working database.  You can modify the observation list, or change constraints, and then create schedules.  You may overwrite the Working database with your changes. To help evaluate the "efficiency" of the schedule, a database report file can be produced that contains statistics regarding the schedule. Once you are happy with the schedule, you write the PPST file.  This puts the database into the Alternate state. TAKO will not allow you to overwrite this target database file.  You can try other scheduling scenarios by either continuing with this database (after saving it in a new file) or by going back to start over with the Approved database.  You may have several alternate databases for the same time period but they all must trace their heritage to the Approved database.  Finally, you develop the best schedule and approve it.  The database is put in the Approved state and TAKO transfers the PPST, along with the associated target database and Master PPSTs, to the MOC Closed subnet.  Your next scheduling session must start with this database to preserve observation continuity.

When the PPST and target database files received on the MOC Closed subnet they are placed in the MOC fileserver where they are available for use by MPS and the Timeline Monitor, and are posted to the MOC Web Site.

2. 
TAKO Data Files

This section describes the input and output data files used by TAKO.

Table 2-1. Input Files

	File
	Description

	Target Database
	targets, constraints, and schedule

	Spacecraft Ephemeris 
	predicted s/c positions and rates from STK

	tako.init
	Mission configuration file – customizes TAKO for Swift

	~/.takorc 
	TAKO user preference file – panel colors (optional)

	~/.takoSession
	TAKO session file – saves session settings  (optional)

	~/.powrc
	POW preference file – saves POW Edit Box settings (optional)

	Target CSV file
	Observation definitions in comma-separated-value format, used for creating or adding to target database. (optional)

	SAA Definition file
	Definition of the SAA polygon (longitude/latitude pairs). (optional – default definition used if none supplied)


Table 2-2. Output Files

	File
	Description

	New or Updated Target Database file
	updated targets, constraints, and/or schedule

	Preplanned Science Timeline (PPST)
	Scheduled events for MPS (window of interest only)

	Master Preplanned Science Timeline (PPST)
	Scheduled events for Timeline Monitor (longer time period)

	Archived Master Preplanned Science Timeline (PPST)
	Previous Master PPST file

	Database Report
	Human-readable listing of the target database content plus schedule statistics. (optional)

	Target CSV file
	Observation definitions in comma-separated-value format. (optional)

	Log file
	saves all the messages sent to the info box 

	~/.takorc 
	TAKO user preference file – panel colors; output by Save Colors

	~/.takoSession
	TAKO session file – saves session settings  - updated on exit

	~/.powrc
	POW preference file – saves POW Edit Box settings 


2.1.
 Input File Descriptions

2.1.1.
Target Database File

The Target Database is described in Appendix B.  At a minimum, the target database contains the time range of the scheduling window, the name of the STK ephemeris file, the observation segment definition records, scheduling rules, and constraint definition records.  When observations have been scheduled, the snapshot records are also stored.  When a PPST is generated, the PPST file name is saved in the currently loaded target database.  Thus each PPST is associated with a target database.  This allows PPT request commands to be traced to the scheduling conditions that created it.  

Technically, this file is optional input because TAKO permits the user to create a target database from scratch, but practically, it is required.  Except for the initial target database, a scheduling session will always be based on the previous session's schedule.  Otherwise, a constraint may be unwittingly violated because the continuity was not maintained with the previous set of PPTs that were uplinked (e.g., the 500 degree/orbit slew constraint)

The default location of all Target Database files is the TAKO data directory specified in the tako.init file.

2.1.2.
STK Ephemeris File

The ephemeris file is the basis of constraint calculations.  It contains the Cartesian position, latitude and longitude, and the RA and Dec of the velocity vector of the spacecraft at one minute intervals.  The ephemeris file is produced by Satellite Toolkit (STK) software configured for Swift.  Whenever the spacecraft vector is updated, a new ephemeris file will be transferred to the ephemeris directory on the SOT workstation.  The location of the ephemeris directory is specified in the tako.init file.  The name of this directory must be coordinated with the configuration file for the STK Automation software because it transfers the file to the SOT workstation.

The filename of the ephemeris used to create the constraints for a schedule is saved in the current target database.   When you load a target database, the associated ephemeris file will be automatically read.

Filename Convention

STK_EPH_yyyyddd_yyyyddd_vv.txt

Where: yyyy is the 4-digit year 

ddd is 3-digit day of the year (001 – 366) 

vv is a version number

The two dates indicate the start and end dates of the ephemeris data contained in the file.

The version number (initial version is 00) is incremented for subsequent versions of the file generated for the same time range of data.  It is a good idea to use the highest version of the file for a certain date range.
The format of the STK ephemeris file is described in the STK Automation User Guide.
2.1.3.
TAKO configuration file

The TAKO configuration file contains values that customize TAKO for Swift.  It also contains values for parameters that may change as the mission progresses.  The values are in the configuration file so that they can be changed without modifying the code.  As delivered, the TAKO configuration file is in the TAKO data directory.

Figure 2.1.3 shows the beginning of configuration file as it is delivered in Release 3.  The part that it not shown is not relevant to Swift or will never be changed without a software delivery.

 #  CVS info - $Id: tako.init,v 3.3 2003/04/29 19:06:57 mmix Exp $ $Name:  $

#

# File: tako.init

#

# Description: Mission configuration parameters for TAKO

#

# Modified for Swift's version of TAKO

#

# Any line starting with a # is considered a comment and ignored.

#

# Configuration fields are:   

#      Key       | Value | (optional) comments

# ----------------START OF USER CHANGEABLE PARAMETERS

# 

#    The user may change the values in this section as needed 

#    to achieve good scheduling results.

#    Refer to the TAKO User Guide.

#

#   Default snapshot minimum and maximum duration.

#   These values are used only if no min and max are given for the observation.

#   Enter value and units.  Default unit is days.

MinSSduration | 3  minutes | Set minimum duration to est. max. slew time

MaxSSduration | 40 minutes | Determined by UVOT maximum

#   Target types for the target database - used in menus and reports

TargetTypes | Prime, Fill-in, BAT survey, GRB, Calibration, BAT catalog, Non-GRB |  Menu items

#   The observation duration is the difference between the time of the

#   start of the observation's first snapshot and the end of the last snapshot.

#   The MaxObsLimit is used to flag long observations in the database report.

#   The value does not affect the scheduling algorithm.

ObsDurLimit | 2 days | Maximum observation duration 

#   Default value for time offset (days) used in roll calculation

RollTime | 10 | days

Continuity | 1 day | default for schedule plot continuity.

#                    e.g., plot starts 1 day before window of interest

#   Slew resource specifications

#   Used to limit the amount of slewing that occurs in a time period

#   Current values limit slewing to 450 degrees per orbital period.

MaxSlewPerPeriod   |  450.0 |   in degrees

SlewPeriod         |  97.0  |   the orbit period in minutes

SlewRestrictSched  |  yes   |  yes: don't allow schedule to deplete resource, 

#                               no: resource is just info

#

#  Target ID and segment number valid range

#    Based on Swift Observation Definition memo - 410.4-AGMT-0011
TargetIdValid     | 10000-79999,100000-16777214 |  no blanks

SegmentValid      | 1-253 |

#

#  Scheduling Complete Threshold.

#  The percent complete that will indicate that scheduling in complete.

#  This just affected the scheduling complete indicator (e.g., "s" column)

#  Scheduling will continue until the requested duration is reached.

SchedDoneThreshold | .9  |  90% of requested duration 

#

#    CAUTION:

#    TakoData, EphemDir, Fileserver and FileserverDB are set by installer

#    and should not be changed by the user without concurrence from

#    the system administrator.

TakoData | $TAKO/lib/data | Default TAKO data directory;

#                           holds target databases, and PPST files

EphemDir | $FS_STK_PRODUCTS |  Ephemeris file directory

#   Master PPST file configuration values

#     Coordinate changes to MasterPPST and MasterPPSThistory

#     with any changes to the Timeline Monitor configuration file.

FileserverDB | $FS_TARGET_DB  | Path to the science database directory

Fileserver   | $FS_PLAN_PPSTL | Path to the science timeline directory

MasterPPST   | MasterPPST.txt | Base file name of the Master PPST file

MasterPPSThistory | 7         | Number of days of PPST history to maintain 

#                               in the Master PPST file

# ----------------END OF USER CHANGEABLE PARAMETERS

#==========================================================================

#    DO NOT CHANGE

#       without concurrence from software developers

#==========================================================================

Project_Name     | Swift | 

Accuracy         | 1     |  schedule resolution, in minutes

Rough_Resolution | 1     |  initial plot res, in minutes

# converting between our data and the internally required keys and units

UniqueID_Keyword     | obs_number | 

RA2000_Keyword       | RA degrees | 

Dec2000_Keyword      | dec degrees | 

ExposureTime_Keyword | duration days |  

#Boresight | 1.0 0.0 0.0| an optional way to define a main boresight

# this field is optional, if efficiency graphs should bear a label

# other than the usual UniqueID (for example, the target name)

IndividualGraphLabel_Keyword | target_name |

# Snapshot overheads

# For Swift there will be overhead for each snapshot, not just for 

# the start of the observation.

Overhead | mnv,Front,1,0,min,yes,slewGreatCircle,0,0,yes,0.785 deg/sec| mnv before obs

# 1. An overhead named "mnv" is applied to the beginning of the snapshot. 

# 2. Priority is 1

# 3. No flat time is applied. 

# 4. flat time units is minutes

# 5. Overhead does use goodtime. not sure what this means

# 6. Use slewGreatCircle proc to compute the overhead time

# 7. No Minimum overhead duration

# 8. No Maximum overhead duration

# 9. slewGreatCircle proc needs the target position to compute the overhead

# 10. Two additional parameters to slewGreatCircle: 

#       Slew rate: float value

#       Slew rate units: e.g., deg/min, deg/sec

#   MOC to SDC ICD - PPST entry and exit labels must be "Begin" and "End"

Optional_In_State | Begin |

Optional_Out_State | End |

# The ephemeris file name is obtained from the target database

# Swift assumes only one type of ephemeris file.

Ephem_Type  | xyzll_eph |  which subroutine reads it in

Ephem_Units | 1.0 |  converts ephem units to km

Ephem_Resolution | 1 | in minutes, usually same as Accuracy

#   Slew Rate (might not be needed)

SlewRate | 0.785 | Nominal PPT slew rate (deg/sec) for computing slew time (from Igor Lazbin's email)

#Optional_Zoom_Type | 1 | quantized

Figure 2.1.3.

 TAKO Configuration File

The configuration file is grouped into user-changeable parameters, and user-must-not-change parameters. The user may change the values in the first section as needed to achieve good scheduling results. The second section should not be changed except in rare circumstances and not without direction from the software maintainer or system administrator.  
The syntax of the configuration record is:

Keyword | Value | Comment

The fields are separated by vertical bars (or pipes).

These tables explain the purpose of each keyword and specify its valid values. 

Table 2.1.3-1. User-changeable Parameters

	Key Word
	Default value
	Description

	MinSSduration 
	 3  minutes 
	Default minimum snapshot duration. The scheduler will not schedule snapshots that are shorter than this value.

Enter value and units. If the units are not given then TAKO assumes the value is days.

This value is used as the default for SSmin field in the Edit Observation panel. 

Currently, the default is the estimated maximum slew time.  Could be larger to avoid wasted slews, but may result in more unscheduled times that could cause safepoints.

	MaxSSduration 
	 40 minutes 
	Default maximum snapshot duration. The scheduler will not schedule snapshots that are longer than this value.

Enter value and units. If the units are not given then TAKO assumes the value is days.

This value is used as the default for SSmax field in the Edit Observation panel. 



	

	TargetTypes 
	Prime, Fill-in, 

BAT survey, GRB, Calibration, 

BAT catalog, Non-GRB 
	Target types for the observation definitions in the target database.  

A comma-separated list of text strings.  Spaces are allowed. 

Target types used to assign observations to groups.  The scheduler currently does not distinguish target types except that it can unschedule targets according to type. The values are used in the Unschedule menu, the Type menu in the Edit Observations panel, and in the database report.  This list will also be used to validate the type field in imported target files. 
The target type can also be used to indicate that a target should not have its roll angle updated automatically. Include the word "lockroll" in the type. e.g., GRB lockroll.

	
	
	

	ObsDurLimit
	2 days
	Maximum observation duration.  The observation duration is the difference between the time of the start of the observation's first snapshot and the end of the last snapshot. The MaxObsLimit is used to flag long observations in the database report. The value does not affect the scheduling algorithm.  The default value is based on SDC's request that observations be completed within 2 days. 

	RollTime
	10
	Default Roll Angle Offset Time. Units are days. This value is used in the computation of roll angle for an observation. The roll angle is computed at a time that is the sum of the start of the schedule and the roll angle offset.  For most targets, a value of 10 will yield a roll angle that is good for about 20 days starting at the schedule start time.  When a CSV file is imported and when the Roll Update option is run, the value in RollTime is used as the roll angle offset. The roll offset time can be changed by the user on a target by target basis in the Target Database Editor (Calc button).

	
	
	

	Continuity 
	 1 day 
	Default for schedule continuity. 

Enter value and units. If the units are not given then TAKO assumes the value is days.

With the default value, the schedule period (and plot window) starts 1 day before window of interest.

	                  

	Slew resource specifications - Used to limit the amount of slewing that occurs in a time period

	MaxSlewPerPeriod   
	  450.0 
	Maximum cumulative slew angle during the period of time specified by SlewPeriod.

Units in degrees.

Current value limits slewing to 450 degrees per orbital period.

	SlewPeriod 
   
	  97.0  
	Length of the time period in minutes.

For Swift, we use the orbit period.

	SlewRestrictSched  
	  yes   
	Constraint flag.

yes: use slew resource to constrain scheduling. Don't allow a snapshot to be scheduled if it causes slew to exceed the MaxSlewPerPeriod. 

no: resource is just plotted for info

	

	Target Id and segment valid ranges are based on Swift Observation Definition memo - 410.4-AGMT-0011

	TargetIdValid     
	10000-79999,100000-16777214
	Target ID valid range.

List of comma-separated numeric ranges.  No blanks are allowed in the list.

	SegmentValid      
	 1-253 
	Segment number valid range. 

List of comma-separated numeric ranges.  No blanks are allowed in the list.


Table 2.1.3-2. Rarely changed parameters

	Key Word
	Default value
	Description

	TakoData 
	 $HOME/TAKO.data
	TAKO data directory.

This is where the target database files and PPST files are stored.

	EphemDir 
	 $FS_STK_PRODUCTS 
	Ephemeris file directory.  Must be coordinated with the STK Automation configuration file.

	FileserverDB 
	 $FS_TARGET_DB  
	Path to the science database directory.  Target database files are stored here after they are approved

	Fileserver   
	 $FS_PLAN_PPSTL 
	Path to the science timeline directory.  PPST, Archive Master PPST,  and Master PPST files are stored here after they are approved

	

	Master PPST file configuration values: MasterPPST and MasterPPSThistory values must be coordinated with the values the Timeline Monitor configuration file.

	MasterPPST   
	 MasterPPST.txt 
	Base file name of the Master PPST file

	MasterPPSThistory 
	 7         
	Number of days of PPST history to maintain in the Master PPST file.  


2.1.4.
TAKO user preferences file (.takorc)

The .takorc contains the user preferences for the TAKO panel colors. The .takorc is not required to start TAKO. It is created in the user's home directory when the user selects the Save Colors menu option.  When the file is present, TAKO uses the specified colors when displaying the TAKO window. Otherwise, the tasteful default colors are used. If you want to get the default colors back, simply delete the .takorc file.  See the User Preferences section for details.

2.1.5.
TAKO session file (.takoSession)

The Tako Session File contains the state of the TAKO session when TAKO is shut down normally via Quit or Save and Quit menu options. The .takoSession file is not required to exist when TAKO starts. The TAKO session state includes the settings of the Autoscheduler Panel, the name of the current Target Database File, and the column configuration of the Target Viewer when TAKO is shut down. When TAKO is started again, the previously accessed Target Database File is loaded, the autoscheduler panel settings are set to the ones you were using, and the Target Viewer column width and order are at their last settings.
The session file also saves the time, user name, and full path name of the version of TAKO that was last used.  These values are useful for troubleshooting.
2.1.6.
POW preferences file (.powrc)

The .powrc contains the settings for the graphs. The .powrc is not required to start TAKO. It is created in the user's home directory when the user saves the settings made using the POW Edit Box.  When the file is present, TAKO uses the specified values when displaying the graphs. Otherwise, the default are used. If you want to get the default values back, simply delete the .powrc file.  See the User Preferences section for details.

2.1.7.
Target CSV file

Observation segment definitions can be imported to and export from TAKO using a comma-separated-value (CSV) text file.  The file can be created from or input to any application that can handle a CSV-format file, such as a database, spreadsheet program or a planning tool.  

The file must contain a heading line followed by data lines:   The fields are described in Table 2.1.6.

Table 2.1.6. Target CSV Fields

	Heading
	Field Description

	target_name
	Human-friendly name of the target (can contain spaces, but not commas)

	type 
	Observation Type: e.g. GRB, BAT survey, Fill-in

	target_ID
	Target identification number (decimal)

	segment
	Observation segment number (decimal)

	FoM
	Figure of Merit value

	RA
	Right Ascension in degrees

	dec
	Declination in degrees

	roll
	Roll in degrees or blank.  If blank, TAKO computes the roll angle using the value of RollTime as the roll angle offset time.

	BATmode
	BAT instrument mode

	XRTmode
	XRT instrument mode

	UVOTmode
	UVOT instrument mode

	duration           
	Observation duration in seconds, how much cumulative time to schedule for this observation. 

	comment
	Text (can contain spaces, cannot contain commas)

	priority            
	Scheduling priority (0-99) where 99 is highest 

	
	

	
	

	SSmin
	Minimum snapshot duration in seconds, or blank.  If blank, the MinSSDuration value from the tako.init file is used.

	SSmax
	Maximum snapshot duration in seconds, or blank.  If blank, the MaxSSDuration value from the tako.init file is used.


The headings must be exactly as documented above because they match keys in the Target Database. The keys are case-sensitive. See the Target DB description for more details on the field contents.

Filename Convention:

Filename extension must be .csv

Example: new_targets_2002165.csv

Sample file:

target_name,type,target_ID,segment,FoM,RA,dec,roll,BATmode,XRTmode,UVOTmode,duration,comment,priority,SSmin,SSmax, 

GRB000911,GRB,12,2,100,34.67,7.8,0,0,0,0,100000.0,Planning Exercise,99,60,9600

Cen A,BAT,31,2,100,201.37,-43.02,0,0,0,0,50000.0,Planning Exercise,30,360,1000

GRB001007,GRB,13,2,100,61.47,-21.9,,0,0,0,20000.0,Planning Exercise,98,,

EXS 1737.9-2952,BAT,32,2,100,264.48,-29.87,0,0,0,0,100000.0,Planning Exercise,30,,

3C 120,BAT,14,2,100,68.3,5.35,34.5,0,0,0,100000.0,Planning Exercise,80,,

GRO J1719-24,BAT,33,2,100,259.94,-24.97,,0,0,0,100000.0,Planning Exercise,30,,

3C 390.3,BAT,15,2,100,280.56,79.76,,0,0,0,100000.0,Planning Exercise,80,,

Nova Per 1992,BAT,34,2,100,65.43,32.91,,0,0,0,100000.0,Planning Exercise,30,,

3C 273,BAT,16,2,100,187.28,2.05,,0,0,0,100000.0,Planning Exercise,80,,

Nova Sco 1994,BAT,35,2,100,253.74,-40.5,,0,0,0,100000.0,Planning Exercise,30,,

4U 0115+63,BAT,18,2,100,169.63,63.74,,0,0,0,100000.0,Planning Exercise,80,,
2.1.8
SAA Definition file 

The SAA definition file contains the longitude/latitude pairs that define the SAA polygon.  This file can be specified in the target database constraint definition for the saa constraint. For example:

Constraint name: saa

Specification: saa file=$TAKODATA/SAA_Swift_default.txt
If a file is not specified in the constraint, a default SAA polygon definition is used.  
Syntax rules for file: 
1. Comment lines (# in first column) may be inserted anywhere.  

2. Any other line will be treated as data. 

3. One line of data consists of the longitude value, one or more spaces, then the latitude value.

4. Maximum number of data lines: 50 (Minimum: 3)

5. The longitude/latitude pairs may be in clockwise or counterclockwise order around the polygon.

6. Longitude may be in the range -180.0 to 360.0

Sample file:

# SAA_Swift_default.txt

#

# Description:  This file contains the default definition of the Swift SAA

# polygon for Tako. 

#

# History:

# 03/05/03   C. Smith     Initial definition using Igor Lazbin's SAA definition (4/30/02)

# 

#

# Longitude  Latitude

     -40.0   -15.0

     -55.0   -20.0

     -65.0   -25.0

     -70.0   -30.0

     -65.0   -45.0

     -55.0   -50.0

     -40.0   -50.0

     -30.0   -45.0

     -15.0   -40.0

       0.0   -30.0

     -15.0   -15.0

     -30.0   -15.0

2.2
Output File Descriptions

2.2.1
Target Database file

The Target Database files saved by TAKO have the same format as input file.

2.2.2.
Preplanned Science Timeline (PPST)

This section describes the format of the PPST file.  The PPST file contains the schedule produced by TAKO. It is input to the MPS where the PPT events are used to add PPT request commands to an ATS load.

Filename Convention
PPST_yyyydddhhmm_yyyydddhhmm_vv.txt

yyyydddhhmm is a time stamp where yyyy is a 4-digit year, ddd is the 3-day day of year and hh is hours and mm is minutes.  The time stamps indicate the beginning and end times of the TAKO window of interest for which the PPST was generated. All events in the timeline occur within this range.

vv is a version number, initially 00.  It is used to distinguish different PPST files created for the same time range.  The highest number is the most recent version.

Example: PPST 20030071200_20030101200_00.txt

File Format

A  PPST record is composed of  4 or 17 columns (fields) which are defined in Table 2.2.2.   Columns 5 through 15 are used to create the PPT request command.  These fields are defined by the FOPPTREQUEST spacecraft command which is documented in the flight software documents.

Table 2.2.2. PPST Fields

	Column
	Description
	Format

	1
	Time Of Event
	YYYY-DOY-HH:MM:SS

	2
	Event Type
	Text: PPT, mnv, saa, ….

	3
	Begin/End of Event
	Text: Begin or End

	4
	Target Name
	Text: Target name or Global

	5
	Target ID
	Unsigned Integer (24 bits)

	6
	Observation Segment Number
	Unsigned Integer (8 bits)

	7
	Observation Number
	Unsigned Integer (32bits)

	8
	RA
	Floating point (64bits) 

	9
	DEC
	Floating point (64 bits)

	10
	Roll
	Floating point (32 bits)

	11
	BAT Mode
	Unsigned integer (16 bits)

	12
	XRT Mode
	Unsigned integer (16 bits)

	13
	UVOT Mode
	Unsigned integer (16 bits)

	14
	Merit Value
	Floating point (32 bit)

	15
	Requested Observation Seconds
	Unsigned Integer (32 bits)

	16
	Comment
	Text

	17
	Target DB Name
	Filename of the Target DB used to create this record


Each record in the PPST file refers to a TAKO event.  The PPST file always contains, for each scheduled snapshot, events with Event Type of PPT; one for the start of the PPT and one for the end.  Also for each snapshot, there will be two events for each slew maneuver  (Event Type = mnv).  Optionally, the PPST may contain other events such as SAA entry and exit time or target occultation event.  The output of these optional events is controlled by its associated constraint definition in the TAKO Target Database (Target DB). 
2.2.3.
Master PPST

The Master PPST contains a summary of the current and previous approved PPST files. The amount of time covered in the Master PPST is controlled by keywords in the TAKO configuration file.

Filename Convention
The filename is also set in the configuration file.  These values must correspond with the values expected by the Timeline Monitor.

File Format

The master preplanned science timeline file format is described in the SDC-MOC ICD in the Master PPST section.  All PPST files have the same format.  The only difference between these files is the time period covered by the data.

2.2.4.
Archived Master PPST

The archived master PPST is a copy of the an older Master PPST and it will have the same time range as the Master PPST and the file name is based on the Master PPST filename. The filename contains a timestamp for the start and end of the data since the Master PPST is archived each time a PPST is approved.

Filename Convention
MasterPPST_yyyyddd_yyyyddd.txt

where yyyy is the 4-digit year 

ddd is 3-digit day of the year (001 – 366)

Example: MasterPPST_2002114_2002146.txt

File Format

The archived master preplanned science timeline file format is described in the SDC-MOC ICD in the Master PPST section.  All PPST files have the same format.  The only difference between these files is the time period covered by the data.
2.2.5.
Database report file

The Database Report  file contains a human-readable report of the contents of the current database file.  It also computes some statistics regarding the schedule.  The statistics include:

1. a list of the observation segments that are over ObsDurLimit days long. (See tako.init)
2. total schedule efficiency (percent of the scheduling period that contains scheduled snapshots)

3. observation efficiency (percent of the scheduled time that contains "good" observation time)
3. the percentage of the scheduling period  used  by each target type.
4. For each scheduled observation, its snapshots are listed in a table and the sum, mean, and standard deviation are computed for duration, slew, and saa fields.
Filename Convention
The report is stored in the TAKO data directory.  The report file name format is: 

<base-target-db-name>_rpt.txt

Example: targ_20023510000_20023540000_00_DB_rpt.txt

Sample File
Database version: Release 3.0

  Plan Start Time: 2003-126-00:00:00

   Plan Stop Time: 2003-133-00:00:00

    Plan duration: 7.0 days

Window Start Time: 2003-126-00:00:00

 Window Stop Time: 2003-133-00:00:00

  Window Duration: 7.0 days

       Plan State: Working

             PPST: 

   Ephemeris File: /filesvr/dev_mocfilesvr/planning/stkproducts/STK_EPH_2003125_2003137_01.txt 

Observation Definition:

 obs_number: 50411695          target_name: Fillin6                  type: Fill-in             target_ID: 80047             

    segment: 3                         FoM: 1                          RA: 335.6340027               dec: -71.64

       roll: 67.353595             BATmode: 0                     XRTmode: 0                    UVOTmode: 4097              

    comment:                      duration: 100000            

   priority: 10                      SSmin: 60                      SSmax: 9000              

Scheduling Results: 

      start: 2003-132-12:34:00        stop: 2003-132-23:49:00    duration: 216                     numSS: 8                 

Snapshots:

  SSN |              start |               stop | duration | priority |     slew |      saa | flag

    1 |  2003-132-12:34:00 |  2003-132-12:37:00 |       27 |       10 |      153 |        0 |    0

    2 |  2003-132-14:10:00 |  2003-132-14:13:00 |       27 |       10 |      153 |        0 |    0

    3 |  2003-132-15:46:00 |  2003-132-15:49:00 |       27 |       10 |      153 |        0 |    0

    4 |  2003-132-17:22:00 |  2003-132-17:25:00 |       27 |       10 |      153 |        0 |    0

    5 |  2003-132-18:58:00 |  2003-132-19:01:00 |       27 |       10 |      153 |        0 |    0

    6 |  2003-132-20:34:00 |  2003-132-20:37:00 |       27 |       10 |      153 |        0 |    0

    7 |  2003-132-22:10:00 |  2003-132-22:13:00 |       27 |       10 |      153 |        0 |    0

    8 |  2003-132-23:46:00 |  2003-132-23:49:00 |       27 |       10 |      153 |        0 |    0

Total                                                  216                  1224          0       

 Mean                                                 27.0                 153.0        0.0       

Stdev                                                  0.0                   0.0        0.0                                            

… more observations …

Constraint Definitions:

         Name: moonang                    Targets: all                          Debit: info                 

         Type: coded                Specification: moontgtangle            Step/Range: range                

         Ymin: 0                             Ymax: 200                      Ephemeris:                      

    Boresight:                            Display: 0                           Output: no                   

     Comments: angle between moon and target                            

         Name: moonlimit                  Targets: all                          Debit: badtime              

         Type: derived              Specification: moonang < 35.0          Step/Range: step                 

         Ymin: 0                             Ymax: 2                        Ephemeris:                      

    Boresight:                            Display: 65                          Output: no                   

     Comments: target vs. moon limit                                    

         Name: occult                     Targets: all                          Debit: badtime              

         Type: coded                Specification: occult 30.0             Step/Range: step                 

         Ymin: 0                             Ymax: 151                      Ephemeris: default              

    Boresight:                            Display: 50                          Output: yes                  

     Comments: occultation 30 degrees

         Name: orbit                      Targets: global                       Debit: info                 

         Type: coded                Specification: orbitdata               Step/Range: step                 

         Ymin: 0                             Ymax: 2                        Ephemeris:                      

    Boresight:                            Display: 1                           Output: no                   

     Comments: orbit start indicator                                    

         Name: ramangle                   Targets: all                          Debit: info                 

         Type: coded                Specification: ramtgtangle             Step/Range: range                

         Ymin: 0                             Ymax: 200                      Ephemeris:                      

    Boresight:                            Display: 0                           Output: no                   

     Comments: angle between velocity vector and target                 

         Name: ramlimit                   Targets: all                          Debit: badtime              

         Type: derived              Specification: ramangle < 10.0         Step/Range: step                 

         Ymin: 0                             Ymax: 2                        Ephemeris:                      

    Boresight:                            Display: 75                          Output: no                   

     Comments: target vs. ram limit 

         Name: roll                       Targets: all                          Debit: badtime              

         Type: coded                Specification: rollsun 9.5             Step/Range: step        

         Ymin: 0                             Ymax: 2                        Ephemeris:                      

    Boresight:                            Display: 45                          Output: no                   

     Comments: sun vector must be within 10 deg of XZ plane in +Z       

         Name: saa                        Targets: global                       Debit: info                 

         Type: coded                Specification: saa                     Step/Range: step                 

         Ymin: 0                             Ymax: 100                      Ephemeris: default              

    Boresight:                            Display: 85                          Output: 1                    

     Comments:                      

         Name: sunlimit                   Targets: all                          Debit: badtime              

         Type: derived              Specification: suntgtang <= 50.0       Step/Range: step                 

         Ymin: 0                             Ymax: 2                        Ephemeris:                      

    Boresight:                            Display: 70                          Output: yes                  

     Comments: target vs. sun limit 

         Name: suntgtang                  Targets: all                          Debit: info                 

         Type: coded                Specification: suntgtangle             Step/Range: range                

         Ymin: 0                             Ymax: 200                      Ephemeris:                      

    Boresight:                            Display: 0                           Output: no                   

     Comments: angle between sun and target      

----------------------------------------------------------------------------------------------------------------

Scheduling Statistics

----------------------------------------------------------------------------------------------------------------

Observation 50402550 exceeds 3.5 days by 0.52 days.

Observation 50411696 exceeds 3.5 days by 2.02 days.

Observation 50411697 exceeds 3.5 days by 1.51 days.

Observation 50411698 exceeds 3.5 days by 3.24 days.

Observation 50411700 exceeds 3.5 days by 3.33 days.

Schedule efficiency:  99.9% of the plan period contains scheduled snapshots.

Observation efficiency:  84.5% of the scheduled time contains good observation time (not in slew or SAA).

Scheduled Target Types:

    Fill-in:  54.6 %

    BAT survey:  18.5 %

    GRB:  22.9 %

    Calibration:   4.1 %

Total unused time: 9.0 minutes (540.0 seconds.)

2.2.6.
Target CSV File

The exported target CSV file has the same format as the input Target CSV file. 

2.2.7.
Log File

The TAKO log file contains messages from the info box plus other messages that record the processing history. A new, time-stamped file is created in the current directory for each TAKO session (A session starts each time Tako is started and ends when the user quits TAKO.).  

Filename Convention

The log file is created in the current working directory. (The directory you are in when you started TAKO.) The log filename format is tako_YYYY_DDD_HHMMSS.log.

File Format

The file contains a copy of the messages written to the Info box plus other messages generated within TAKO for troubleshooting. The messages are time stamped.

Sample File

Started the Swift Target Scheduler, TAKO Release 3.0

2003-126-16:48:09 Init from configuration file: /filesvr/dev_mocfilesvr/softconfig/general/tako.init

2003-126-16:48:09 functions available include: occult roll lineofsight Sat2SatLOS anglebetween sunangle intsunangle saabrazil saa goodtime xteroll

 suntgtangle moontgtangle ramtgtangle orbitdata rollsun

2003-126-16:48:09 ephemeris routines available include: quick_eph yyyy_eph deriveorbit mjd_eph xyzll_eph

2003-126-16:48:10 MinSSduration = 3  minutes

2003-126-16:48:10 MaxSSduration = 40 minutes

2003-126-16:48:10 TargetTypes = Prime lockroll, Prime, Fill-in, BAT survey, GRB, Calibration, BAT catalog, Non-GRB

2003-126-16:48:10 ObsDurLimit = 3.5 days

2003-126-16:48:10 RollTime = 5

2003-126-16:48:11 Continuity = 1 day

2003-126-16:48:11 MaxSlewPerPeriod = 450.0

2003-126-16:48:11 SlewPeriod = 97.0

2003-126-16:48:11 SlewRestrictSched = yes

2003-126-16:48:11 TargetIdValid = 10000-89999,100000-16777214

2003-126-16:48:12 SegmentValid = 1-253

2003-126-16:48:12 SchedDoneThreshold = 1.

2003-126-16:48:12 TakoData = $HOME/TAKO.data

2003-126-16:48:12 EphemDir = $FS_STK_PRODUCTS

2003-126-16:48:12 FileserverDB = $FS_TARGET_DB

2003-126-16:48:13 Fileserver = $FS_PLAN_PPSTL

2003-126-16:48:13 MasterPPST = MJMtestMasterPPST.txt

2003-126-16:48:13 MasterPPSThistory = 7

2003-126-16:48:13 Project_Name = Swift

2003-126-16:48:13 Accuracy = 1

2003-126-16:48:14 Rough_Resolution = 1

2003-126-16:48:14 UniqueID_Keyword = obs_number

2003-126-16:48:14 RA2000_Keyword = RA degrees

2003-126-16:48:14 Dec2000_Keyword = dec degrees

2003-126-16:48:14 ExposureTime_Keyword = duration days

2003-126-16:48:15 IndividualGraphLabel_Keyword = target_name

2003-126-16:48:15 Overhead = mnv,Front,1,0,min,yes,slewGreatCircle,0,0,yes,0.785 deg/sec

2003-126-16:48:15 Optional_In_State = Begin

2003-126-16:48:15 Optional_Out_State = End

2003-126-16:48:15 Ephem_Type = xyzll_eph

2003-126-16:48:16 Ephem_Units = 1.0

2003-126-16:48:16 Ephem_Resolution = 1

2003-126-16:48:16 SlewRate = 0.785

2003-126-16:48:16 TAKO data directory has been set to /home/mmix/TAKO.data.

2003-126-16:48:16 Ephemeris directory has been set to /filesvr/dev_mocfilesvr/planning/stkproducts.

2003-126-16:48:17 PPSTL file server directory has been set to /filesvr/dev_mocfilesvr/planning/PPSTL.

2003-126-16:48:17 Master PPST file has been set to MJMtestMasterPPST.txt.

2003-126-16:48:15 Overhead = mnv,Front,1,0,min,yes,slewGreatCircle,0,0,yes,0.785 deg/sec

2003-126-16:48:15 Optional_In_State = Begin

2003-126-16:48:15 Optional_Out_State = End

2003-126-16:48:15 Ephem_Type = xyzll_eph

2003-126-16:48:16 Ephem_Units = 1.0

2003-126-16:48:16 Ephem_Resolution = 1

2003-126-16:48:16 SlewRate = 0.785

2003-126-16:48:16 TAKO data directory has been set to /home/mmix/TAKO.data.

2003-126-16:48:16 Ephemeris directory has been set to /filesvr/dev_mocfilesvr/planning/stkproducts.

2003-126-16:48:17 PPSTL file server directory has been set to /filesvr/dev_mocfilesvr/planning/PPSTL.

2003-126-16:48:17 Master PPST file has been set to MJMtestMasterPPST.txt.

2003-126-16:48:17 Master PPST file history has been set to 7 days.

2003-126-16:48:17 Configuration file load completed.

2003-126-16:48:30 System initialization complete.

2003-126-16:48:30 Loading targets and schedule from /home/mmix/TAKO.data/targ_20031260000_20031330000_01_DB.tcl

2003-126-16:48:31 Loading file /home/mmix/TAKO.data/targ_20031260000_20031330000_01_DB.tcl, please wait

2003-126-16:48:33 Using ephmeris routine "xyzll_eph" to load file: /filesvr/dev_mocfilesvr/planning/stkproducts/STK_EPH_2003125_2003137_01.txt

2003-126-16:48:36 Ephemeris is loaded.

2003-126-16:48:37 Global constraints loaded.

2003-126-16:48:38 Updating the graphs

2003-126-16:51:01 Target database is loaded from /home/mmix/TAKO.data/targ_20031260000_20031330000_01_DB.tcl

2003-126-16:57:42 TAKO normal exit

3.
Running TAKO
The SOT user account must be setup according to the installation instructions in Appendix A.  As a user, you only need to know about  the TAKO data directory and the command to start TAKO.  The TAKO data directory exists under the SOT user's home directory.  An environment variable, TAKODATA, is set to that directory for your convenience.  Also an alias command, runtako, has been defined that starts TAKO using the installed TAKO configuration file. 

For Swift operations, TAKO must always be run against the same TAKO data directory.  This maintains scheduling continuity. Also, TAKO is a single user system, so only one person at a time can use TAKO.

The easiest way to start TAKO is:

% runtako

The first time TAKO is run, the user must load a target database.  A sample database is provided with the software installation. You may modify this database or start with an empty database.  In subsequent runs of TAKO, the target database used in the previous session will be loaded automatically.  

TAKO can also be told to load a particular database on startup by using the load option.  

Example:

% runtako load=$TAKODATA/targ_20032330000_20032360000_DB.tcl

3.1. 
Typical Scheduling Process

This list shows steps in the typical daily scheduling process:

1. Start Tako and load the current target database.

2. Set the scheduling period and choose a new ephemeris if necessary.

3. Update observation segment definitions (add, change, archive). 
4. Schedule the observations.

5. Evaluate the schedule.

6. Save the schedule (in the target database).

7. Create the PPST.

8. Approve the PPST (transfer files to the MOC subnet).

The following sections explain how to use Tako to do each of the steps.

3.1.1.
Start Tako

Start Tako by running this command:

% runtako

Unless this is the first time you have run TAKO,  the database whose name is saved in the .takoSession file will be loaded automatically.  Typically, you want to start with the last approved database so that there is continuity from one PPST to the next.  (If you don't want to work with the target database from the previous session, you can choose another file.  Select File=>Load=>Load Target DB from the menu bar.)

.

TAKO will load the information from the database, read the ephemeris file, and compute the constraint data. This may take a few minutes. Then it plots schedule timelines in its main panel, displays the observation list, and a message log window (Info box).

The currently scheduled snapshots will be plotted on the "mainevents" timeline. Global constraints, such as SAA and Slew, will also be plotted.

3.1.2.
Set the scheduling period

Start the target database editor by selecting File=>Edit=>Edit TargetDB from the menu bar.  The editor comes up in the "Context" panel.  The other panels are "Observations" and "Constraints".  Enter the date for the new scheduling period.  Press the TAB key and the window start entry will be updated.  Adjust the duration and window of interest start time if necessary.  Click the Select File button to choose the most up-to-date ephemeris.  The files are listed in a selection dialog.  The name of  the file contains the range of times for which the file contains data. Select the ephemeris file that includes the start and end of the scheduling period and press the Enter key.

Click the Apply button when you are done updating the context. The lower portion of the edit panel will be updated.  If you don't press Apply button, the new entries will not be applied. 

If the Ephemeris file is changed, the current schedule is considered invalid.  The currently scheduled snapshots will be deleted when the target database editor is closed because a new ephemeris may change the constraint values and thus the goodtimes may now be different.
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Figure 3.1.2. 
Context edit panel

3.1.3.
Update the observation segment definitions

Select Observations=>Edit Observations from the menu bar of the Target Database Editor to switch to the observation editor. The observation editor allows you to add, modify, or remove observation segment definitions in the target database. The observation segment definition editor panel shown in Figure 3.1.3 is made up of two sections:  the edit pane and the definition list.  New definitions may be added by typing in the edit pane fields, or by importing the definitions from a CSV file.  The format of a Target CSV File is given in the input file definition section.  

Certain fields of an existing observation segment definition may be modified.  To modify the observation, select the observation from the definition list.  If the observation is scheduled, you may modify only the fields in the Scheduling Rules area or the target name, type, or comment fields.  If the observation is not scheduled, then you may change any field.  As always, the Target ID and the RA and declination must be consistent.  If the observation is scheduled, information is also displayed in the Schedule Summary box. The list of snapshots can be viewed by selecting the View Snapshot List button. The sched_status field indicates whether the observation is scheduled or not.  The values of the sched_status field are similar to the values of the "s" field in the Target Viewer.  The status codes are described in Table 4.2.3. 

Fill-in Targets

Fill-in targets are just a set of observations that are guaranteed to have at least one visible (within constraints) at all times. These observations are delivered in a CSV file so they can be imported into an existing database.   The priority is lower than any of the primary observations so that the fill-in targets will be scheduled only during gaps in the primary observations.  The target type is set to "Fill-in".  Thus fill-in targets can be unscheduled as a group if desired.  

The observation definitions of the fill-in targets will have to be maintained by the user.  Periodically, the segment numbers of the fill-in targets need to be updated to accommodate science data processing needs.  Also the roll angles need to be updated every few weeks.  
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Figure 3.1.3. 
Edit Observations panel 

The fields are validated when you press TAB or Enter, and when you click on the Add or Change buttons. (The fields are not validated if you use the mouse to select a new field.)   

The Restore button restores all of the edit fields to the values they had originally.  It is equivalent to selecting the entry again.

The Clear button sets all of the edit fields to default values.

The Delete button removes an observation segment definition from the database. It is enabled only for observations that have not been scheduled.  There is no "undelete" feature.  So don't delete an observation unless you mean it.

The Archive button also removes an observation segment definition from the database. It is enabled only for observations that are scheduled.  You may wish to archive observations that have been completely observed, or can no longer be scheduled due to constraints.  If the duration in the Schedule Rules area and the duration in the Schedule Summary area are equal (or close enough), then this target is completely scheduled. If the stop time of the scheduled snapshot in the past, then it is safe to archive the observation.  Archiving old observation cuts down on the clutter in the observation list.  Keeping the observation list short also slightly reduces the time it takes to autoschedule because the autoscheduler does not have to examine as many observations to determine what can be scheduled.

Scheduled observations are archived rather than merely deleted because we need to keep a list of assigned observation numbers.  This list is used, in conjunction with the observations in the current database, to ensure that observation numbers are not reused and that the same target ID is not assigned to different locations.  There is no "unarchive" feature, so don't archive an observation unless you are done with it.

3.1.3.1. When to Add

You must use Add when you create a new observation segment definition.  

Most commonly, you will create a new definition based on an existing scheduled observation definition when a new roll angle is needed, when a new initial instrument mode is desired, when the observation segment has been completely scheduled, or when the two-day limit on an observation segment has occurred.  After you make the necessary changes in the parameters, you must change the segment number to the next available value (usually by adding 1).

You must add a new segment if you change any fields in a scheduled observation segment that are used as parameters to the FOPPTREQUEST command:

· Target id

· Segment number

· Figure of merit (FoM)

· Right Ascension (RA)

· Declination

· Roll

· BAT instrument mode

· XRT instrument mode

· UVOT instrument mode

3.1.3.2 When to Change

The Change button is used after you change any parameter in an unscheduled observation segment.  It can also be used after changing those parameters in a scheduled observation segment that do not affect the FOPPTREQUEST command parameters. The fields in the Scheduling Rules section can be changed for any segment as well as the target name, target type, and comment fields.  

Most commonly, you will want to change the duration in order to schedule additional snapshots for the observation.   Also, you may change the priority of an observation segment if it is not getting its share of the schedule.  

NOTE: If you change any of the scheduling rules of an observation segment, TAKO will unscheduled all observations in the window of interest when the file is saved or when the editor is closed.  This is so the observation list can be rescheduled according to the new rules.  Otherwise, a segment that had a low priority will take up time that the new higher priority segment should have.  This is why you are encouraged to save the target database before entering the editor.

3.1.3.3 Importing a Target CSV file

The import function enables targets to be imported from other planning applications or from a spreadsheet.  Select File => Import Targets (.csv) to show a file selection dialog that lists all of the files in the default data directory that have csv as the extension.  You can change the directory to the location of your CSV file.  The file format is described in Section 2.1.7. The lines in the file are read, validated, and added to the observation list. Validation messages are written to the log screen. If a line is invalid, it is ignored and processing continues with the next line.  If the target id and segment in a line is the same as an existing or archived observation segment, it is treated as an invalid line.

3.1.3.4 Saving changes

After making changes to the target database, you may save the information.  If the target database state is Working, then you may select  Save Target DB ( Save  to replace the current file.  If the state is Alternate or Approved, select Save Target DB ( Save As since you must save the changes under a new file name.  The recommended format is targ_YYYYDDDHHMM_YYYYDDDHHMM_VV_DB.tcl 

where the times are the start and end of the schedule period and VV is a version number starting with 00.   The filename must end in "DB.tcl" or else the selection dialog will not display it.

NOTE: Saving a target database can be more complicated than just writing the new records to a file.  Changes during the editing session may affect the validity of the current schedule. The change in ephemeris or constraint definitions may cause currently scheduled snapshots to no longer be in a Goodtime period.  Since the definitions must be consistent with the schedule, the snapshots in the window of interest are deleted before the database is saved when any changes are made that affects scheduling.  

3.1.3.5 Exiting from the editor

After saving the modified target database, select File=>Close to exit from the editor.  If target database was not saved during the session and if the changes affect the validity of the current schedule, the snapshots in the window of interest will be deleted when you exit.  

3.1.4.
Schedule the observations

There are many ways to use the observation scheduler:

1.  Place the targets by hand using the timeline.  

2.  Automatically schedule from the entire target list

3.  Automatically schedule from a subset of the target list 

4.  Combination of the above

A subset of the observation list can be scheduled either by putting the subset into the pool, or by using the Target Selection function.  Even though the Autoscheduler panel allows you to choose "All targets", this means all observations currently displayed in the Target Viewer.  The Target Selection function can be used to reduce the number of observations displayed.

Unlike the legacy TAKO, the Swift observation scheduler can interleave snapshots from several targets.  So when one target can't be observed, a snapshot from another target can begin. Also, the Swift observation scheduler can schedule partial observations.   The observation may start in the current scheduling period and have some of its snapshots in this period, but may not be completed due to constraints and the presence other scheduled snapshots.  When the scheduling period is advanced, the remaining time can be scheduled for the partially scheduled targets.
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 Figure 3.1.4. 
Autoscheduler Panel

Click the Autoschedule button to initiate the autoscheduler function. The autoscheduler sorts the observations by priority to create an ordered target list. Then it removes the observations that do not have any "goodtime" during the window of interest to create a visible target list.  These targets are visible in the context that they can be observed without violating constraints. For each observation in the visible target list, the autoschedule attempts to schedule the observation.  It starts at the window start time and bumps the observation start time until scheduling succeeds or the end of the window is reached.  The autoscheduler places as many snapshots on the timeline as it can.  Thus, a high priority observation will have all of its snapshots scheduled before a lower priority observation is scheduled.  The lower priority observation is scheduled in the gaps between the high priority observation's snapshots. 

3.1.5.
Evaluate the schedule

The File ( Output ( Write Database Report menu option creates a file containing a human readable report of the contents of the current database file.   It also computes some statistics regarding the schedule.  The statistics are displayed in the info box as well. This report is described in the Output file section above.

During a scheduling session, you may go through several iterations of altering observation priorities or durations, autoscheduling and evaluating the schedule until the desired schedule is achieved.
3.1.6.
Save the schedule (in the target database)

It is good practice to save your work periodically.  Use File=>Save to save to the current target database file name.  Use File=>Save As to save with a different file name.  TAKO will not let you Save over an Alternate or Approved file.  You will normally start the scheduling session with the most recent approved database, make the necessary changes, then save the file, using Save As, as a new working database.

3.1.7.
Create the PPST

Once you are happy with your schedule, you need to write it as a preplanned science timeline (PPST) file.  NOTE:  The target database must be saved before doing this. Use the File => Timeline => Write preplanned science timeline (PPST) menu option. It may take a minute to write the time.  Wait until the completion message is written in the info log window.  The target database state is changed to Alternate.  You may no longer save to this particular file.   

If you decide you don't like this PPST, you may delete it using the File => Timeline => Delete PPST menu option.  This deletes the PPST file and resets the target database to the Working state.

3.1.8.
Approve the PPST

When you are ready to commit this timeline to be uplink to the spacecraft, use the File => Timeline => Approve PPST menu option.  TAKO does four things:

1. Sets the Target Database file to the Approved state.

2. Creates the Archive Master PPST from the current Master PPST

3. Updates the Master PPST with the new timeline.

4. Transfers the Target Database, the PPST file, and the two Master PPST files to the MOC subnet.

4.
TAKO User Interface

4.1.
 TAKO main display

4.1.1.
Main Menu
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The pull-down menus on TAKO's main display can be changed to tear-off menus.  You can make them stay open by clicking on the dotted line at the top of the list.  The menu is then displayed in its own window.  When you close the window, the menu reverts to a pull-down menu.  The pull-down feature is handy to use with the Target menu.  It makes it easier to put observations in the scheduling pool when you keep the menu open.

4.1.1.1. 
File
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Figure 4.1.1.1.
The File menu.

4.1.1.1.1
 Load

The Load menu has a cascade menu with two choices:

· Load Target DB

· Load Ephemeris

Load Target DB is used to select and load a Target DB.  This allows you to work on an alternate schedule by reloading the last approved Target Database file.

Load Ephemeris is used to select a new ephemeris file.  A new ephemeris file is usually selected using the Target Database Editor.  This menu is a short-cut most often used after advancing the schedule (see the Schedule menu).  Loading a new ephemeris will unschedule any currently scheduled snapshots in the window of interest.  It does that because the new ephemeris may change the constraint values and cause the currently schedule snapshots to occur when constraints are violated.
4.1.1.1.2
 Edit

The Edit menu has one option: Edit Target DB.

This brings up the Target Database Editor panel.  Operation of the Target Database Editor is described in another section.

4.1.1.1.3 
Save

The Save menu has two options:

· Save Target DB

· Save Colors

The Save Target DB menu option is used to save the target database to the current filename.  If the target database is Alternate or Approved, an error dialog will be displayed advising you to use the Save As menu.  You are only allowed to save changes to a Working database. 

The Save Colors menu option is used to save the currently select colors in the TAKO user preferences file (.takorc).  The Change Colors feature is entered when the middle mouse button is clicked in one of the display windows.  

4.1.1.1.4 
Save As

The Save As menu has only one option: Save Target DB As.

A file selection dialog is presented.  TAKO suggests a valid target database name.  There is usually no reason to change the directory or the suggested filename. Click Save to accept the name and save the database to the new file name. The suggested filename has the format: targ_YYYYDDDHHMM_YYYYDDDHHMM_VV_DB.tcl.  Click Cancel to exit the dialog without saving the database.

TAKO creates the target database filename based on the schedule start and stop times.  If any database files with the same start and stop times already exist, then TAKO bumps the version number of the highest version to create a unique filename.  

4.1.1.1.5
Output

The Output menu is for miscellaneous output options:

· Write Database Report

· Export Database (CSV)

· Write Graphs

The Write Database Report menu option creates the Database Report file described in the Output File Description section.

The Export Database (CSV) menu option creates a comma-separated file containing the observation definitions in the currently loaded target database.  The format is described in the Output File Description section.

The Write Graphs menu option saves the current timeline window as a Postscript file.  This file can be printed to a postscript printer with the UNIX lp command.

4.1.1.1.6 
Timeline

The Timeline menu deals with the preplanned science timeline.  The options are:

· Write Preplanned Science Timeline (PPST)

· Delete PPST

· Approve PPST

· Retransfer PPST

The Write Preplanned Science Timeline (PPST) option creates the PPST file based on the currently scheduled snapshots and events.  The target database must be saved before choosing this option.  You'll get an error dialog if it is not. You only want to write the PPST once you are satisfied with your schedule.  It may take a minute to write the timeline.  The PPST file is saved in the TAKO data directory. Wait until the completion message is written in the info box (log window) before doing anything else.  The target database is now put in the Alternate state.  You may no longer save to this particular target database file.  

The Delete PPST menu option deletes the PPST file and resets the target database to the Working state. Use this when you decide you don't like this PPST and want to continue tweaking the schedule.  This option is only available when the database is in the Alternate state.

The Approve PPST menu option transfers the PPST (and other files) to the MOC Closed subnet.  Use Approve PPST only when you want to commit this schedule to be uplinked to the spacecraft.  TAKO does four things when a PPST is approved:

1. 
Sets the Target Database file to the Approved state.

2. 
Creates the Archive Master PPST from the current Master PPST

3. 
Updates the Master PPST with the new timeline.

4. 
Transfers the Target Database, the PPST file, and the two Master PPST files to the MOC subnet.  The only error you should get is a file transfer failure.   This could happen if the workstation you are transferring to goes down or there is a problem in the network connection.  See the troubleshooting section for more details.  Once the problem is solved, use the Retransfer PPST option to attempt the file transfer again. (Move to troubleshooting section: The transfer is done in a script called TransferToMOC.pl. The transfer is done by copying these files to the transfer directory. The files are combined into a "tar" file prior to transfer, so you may see a .tar file remaining in the transfer directory if the transfer files.)  

The Retransfer PPST menu option attempts the file transfer again.  You need to use this only if you get a message stating that the file transfer to the MOC failed during the Approve PPST function.  Also, you need to have remedied the problem that caused the failure.  This only attempts the file transfer.  It does not update the Master PPST again.

4.1.1.2. Plotting

The Plotting menu allows the user to change the characteristics of the timelines in the POW box. These options are typically not needed for routine scheduling.  Plotting single curve choices may be useful for getting an overview of the "goodtimes" or of the roll angle constraint of several targets at once in order to analyze why a schedule is turning out the way it is.
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The Plot Timeline Curve Set menu option replots the timeline.  It is mainly used to restore the timeline plots after showing the "single curves".  It can also be used to replot the timeline if it "looks funny" after editing the database, especially if a constraint definition is added.  

The Single Curve Choices menu option allows the user to select one or more event curves to be plotted for all observations or a subset of observations.  For example, select "goodtime" and "roll"  to show whether the roll constraint is violated for any observation.

The Plot Single Curve Set menu option redraws the timeline window so that it only shows the selected "single curves".   This is not typically something you'd want to do for all targets in the observation list at once (it may take a long time).    Use the Target Selection entry to narrow the list, first. (See Section 4.1.3.3.)

The Align Graphs menu option resets the timelines back to their original positions.   You may have moved timelines to compare them. 

The Lock Graphs? check box controls whether the timelines can be moved horizontally or not.  Check the box to prevent the user from moving the timelines horizontally.  Unchecked, the user can move the timelines horizontally, but that is not recommended.

The MJD Tickmarks check box controls whether or not the timescale on the plot X-axis is shown as Modified Julian Date (MJD) or as a calendar date. This is typically unchecked so that the time is shown in the same format that the rest of the MOC uses.

4.1.1.3. Target
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The Null Target menu option deselects the currently selected observation.  

The options involving the "pool" are fairly self-explanatory.  The "pool" is a subset of the observation list.  The Autoscheduler can be told to schedule only the "pool" observations. 

Observations can be added to the pool individually by selecting the observation from the Target Viewer, then clicking the Cast current target into pool menu option.  The word "pool" is added to the status column of the observation.  Several observations can be added to the pool at the same time. First display a subset of the observations using the Target Selection entry.  Then click on the Cast all listed targets into pool menu option. All the listed observations will have "pool" added to the status column.  

To remove the observations from the "pool", use the Pull current target from the pool menu option or the Pull all listed targets from pool menu option. The status column will be update to show that the observation is no longer in the "pool". 

NOTE:  Currently,  lock and  ignore do nothing useful, so they are disabled. 

4.1.1.4. Schedule
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Unschedule Targets

Unschedule Targets offers several options for removing scheduled snapshots from the schedule. The snapshots are unscheduled only during the current window of interest.  Therefore, any snapshots scheduled before the start of the window of interest or after the end of the scheduling period will not be removed.  When a snapshot it unscheduled, the resources used by the snapshot are restored. You will see the slew resource is replenished.   
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Current – unschedules the snapshots for only the currently selected observation

All – unschedules the snapshots for all observations

Autoscheduled – unschedules the snapshots for only the observations that were scheduled using the autoscheduler.  Observations scheduled by the user clicking on the timeline will remain scheduled.

The remaining options are target types.  You may unschedule observation based on its type.  Selecting Fill-in will unschedule all of the observations with the Fill-in type.

The set of target types are defined in the TAKO configuration file.  The target type is assigned when the observation definition is created in the Target Database Editor.

AutoSchedule Control Panel

The AutoSchedule Control Panel menu option is used to initiate the autoscheduler. Clicking on the AutoSchedule Control Panel menu option displays the Auto-Schedule Parameters window.  These parameters allow the autoscheduler behavior to be customized.  Figure 4.1.1.4-1 shows the recommended settings for the typical Swift scheduling scenario.
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Figure 4.1.1.4-1.  
Autoschedule Control Panel

Observation Set allows the user to indicate which set of observations to input to the autoscheduler.
Check All targets to use all of the observations that are currently displayed in the Target Viewer list.  You may use the Target Selection entry to display a subset of the observation list.  Only this subset will be input to the autoscheduler.

Check 'Pool' targets only to use the observations marked as pool targets.  These targets will have "pool" in the "s" column in the Target Viewer list. Observations are marked as pool targets using the Cast current target into pool menu option under the Target menu.

Start scheduling from… allows the user to indicate the time after which new snapshots are to be scheduled.

Check Window start time and new snapshots will be scheduled starting at the beginning of the window of interest.  This selection is recommended for Swift.

Check Last-clicked time from timeline and new snapshots will be scheduled starting at the marker.
Check Last scheduled item and new snapshots will be scheduled after the last scheduled snapshot.

End scheduling from… allows the user to indicate the time after which no new snapshots are to be scheduled.  For Swift, since the end of the window of interest and the end of the schedule period are the same, this option is not useful.
Window stop time

Schedule stop time

First Priority Sort Field  allows the user to indicate the order in which observations will be scheduled based on observation segment definition field values.  All fields are available for selection, but "priority" is recommended for Swift. If none is selected then the observations are not scheduled in any particular order.

The sort order choices are:

Lowest/smallest/earliest – Smaller value first, ascending order
Highest/largest/latest – Larger value first, descending order (recommended for Swift)

Second Priority Sort Field allows the user to indicate a secondary sort order for observations after they are sorted by the first priority field. All observation definition fields are available, but "none" is recommended for Swift.  There may be a situation where duration  or FoM value may be a useful secondary sort criterion.
The sort order choices are:

Lowest/smallest/earliest – Smaller value first, ascending order
Highest/largest/latest – Larger value first, descending order 

After the autoscheduler parameters are set, click the Autoschedule button to initiate the autoscheduler.  When the estimated time it may take to run the autoscheduler is greater than 15 minutes, a dialog box is displayed to prompt you to continue running the autoscheduler or to cancel. 

When the autoscheduler runs, it displays another dialog box to show progress and to allow you to stop the autoscheduler (Figure 4.1.1.4-1).
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Figure 4.1.1.4-2.
Scheduling Status Dialog

Number of targets selected is the number of targets the autoscheduler found that were eligible to be scheduled.  These targets are taken from the observations currently displayed in the Target Viewer.  Observations that are completely scheduled are not included in the count.  

Visible targets is the number of targets have "goodtime" periods in the window of interest. This value is incremented as the autoscheduler examines each target in the selected list.  If a target does not have any "goodtime", then it is removed from the list so the autoscheduler doesn't waste time trying to search for a place to schedule it.

Targets scheduled so far is incremented as each observation is scheduled.

Abort is used to prematurely exit from the autoscheduler. The observations scheduled so far will remain scheduled.

Advance Schedule

The Advance Schedule menu option updates the schedule start and stop times so that the schedule start time is midnight of the current day and the window of interest start time is adjusted to keep the current window duration.  The schedule stop time is adjusted to retain the current schedule period.   This is a short cut to be used when the only change to the database is to advance to time window.  TAKO reloads the current ephemeris using the new time range, regenerates the constraint curves, and replots the timelines. Currently, scheduled snapshots will not be affected.  The "s" field in the Target Viewer may be updated to reflect the current status. For example, an observation that was "s p" may became "t p" if the starting snapshot is before the new window of interest.

After advancing the schedule, you should save the target database using Save As.  Now you can schedule to new time period as necessary. 

4.1.1.5.
Canvas

The Canvas menu allows the user to configure the placement of the display components on the screen, and control which timelines are sensitive to the scheduling mouse button.  These options are not likely to be needed for routine scheduling.

[image: image18.png]I enable POW edithox

I~ pop Targets —

I~ pop Info hox
" [~ pop POW

—  Allow Scheduling on..




The enable POW editbox checkbox displays the POW Edit Box.  This feature allows the user to customize the graph appearance (Fonts, colors, etc).  The custom values are stored in ~/.powrc so that they are available for the next session.  This feature should be used rarely.  Delete ~/.powrc to restore the default values.

Select the  pop Targets checkbox to remove the Target Viewer from the main display and put it in a separate window.  The nice thing about having the Target Viewer in a separate window is that you can resize the window to show more observations at a time than the 10 or so you see when it's part of the main display.  It also allows the POW box to expand to show all of the timelines without needing to scroll.  Deselect the checkbox to put the Target Viewer back on the main display. 

Select the pop Info box checkbox to remove the Info box from the main display and put it in a separate window. The window can be resized to show more lines at one time.  Deselect the checkbox to put the Info box back on the main display. 

Select the pop POW checkbox to remove the POW box from the main display and put it in a separate window.  Deselect the checkbox to put the POW box back on the main display. 

The Allow Scheduling on… menu option allows the user to indicate which timelines are enabled for scheduling.  This means that an observation will be scheduled if you left-click on the timeline.  By default, scheduling is allowed on "mainevents" and "target". If you plan on doing much manual scheduling, then you may want to allow scheduling on the "goodtime" timeline.

4.1.1.6. 
Help

Not implemented

4.1.2.
Timeline window (POW box)

The timeline window provides a graphical representation of the schedule.   It consists of three functional parts:  The timeline area, the marker time display, and the Pan and Zoom buttons.

4.1.2.1. Timeline area

The timeline area plots are implemented with a software package called POW, hence the name POW box.  

The first four timelines are permanent.  They are defined by the application.

· The "mainevents" timeline shows the scheduled snapshots.  Each snapshot is represented by a solid blue box.  The left edge of the box is on the start time of the snapshot and the right edge is at the stop time.  The height of the box indicate the observation's priority (tall boxes are high priority targets.) One indication of a completely filled schedule is that there are no visible gaps in between the boxes. This timeline is also used for input.  The user can select a target by clicking a blue box with the right mouse button.  The user can schedule a selected target by clicking the left mouse button on an empty area of the timeline.

· The "target" timeline shows, for the selected observation, its currently scheduled snapshots. 

· The "goodtime" timeline shows, for the selected observation, the blocks of time during which no constraints are violated.  These are the good times for scheduling snapshots.

· The "slew" timeline shows the value of the slew angle resource. When the value is near zero, no observations can be scheduled.  So if a gap in "mainevents" coincides with a low "slew" value, then no observation can be scheduled in that gap because any slew to an available target would cause the slew angle limit to be violated.  

The other timelines are controlled by the constraint definitions in the target database.  As delivered, the constraints are:

· The "saa" timeline is a global constraint since it does not depend upon which target is selected.  It does not affect scheduling, but it is used to compute the requested observation seconds  (REQOBSSECS) field for the PPST output file.

· The "roll" timeline shows for the selected target, any roll angle constraint violations. The times when the constraint is in violation are shown as red boxes, otherwise the line is empty.  Empty is good. If a violation is indicated, you may need to update the observation's roll angle.  If the roll angle constraint is violated for the entire window of interest, then the observation will not be scheduled.

· The "ramlimit", "sunlimit", "moonlimit", and "occult" timelines show violations of the ram angle, sum angle, moon angle, and earth occultation constraints. (See Requirements)

· The "orbit" timeline shows a blip at the start of each orbit (ascending node time).  This is not used for automatic scheduling, but may be a useful reference.  

· Other timelines will be displayed if additional constraints, such as the time critical (TC) constraints are defined by the user.

· Other timelines represent data used in generating constraints, such as moonangle.  They are for information only and their plots are purple.  

The display order of the timelines is controlled by the Display parameter in the constraint definition record.  Also, to reduce the number of timelines plotted, any of these timelines can be hidden by setting the Display parameter to 0.  See the database description for more details.

One nice feature of POW that the user can compare two or three timelines by dragging the timeline up or down the Y axis to overlay another timeline.  

4.1.2.2. Marker time display

The marker time displays the time that corresponds to the marker ( + cursor) position on the timeline.  The time is displayed as calendar date and time with the 3-digit day of year.  This time format is consistent with the format used in the rest of the MOC. In this release, the MJD is also displayed.

4.1.2.3. Timeline Zoom and Pan

When a scheduling period is long, the timeline plot may not give the resolution necessary to see where to click or how big a gap really is.  The zoom feature gives the user a close-up view of a section of the timeline.

Pan Left, Zoom In, Zoom Out, and Pan Right buttons have a slider bar below them.  The range of the plotted area is shown when you Zoom.

The init file has a variable Optional_Zoom_Type when set to 1, you can only zoom in or out by 1 magnification.  When set to 0, zooming is effectively unlimited. 

Zoom In will magnify the area around the marker.  If the marker is not set, it magnifies around the center of the window of interest.

Zoom Out expands the visible time range.  It stops zooming out when the original schedule start and stop times are reached.

Pan Left and Pan Right are effective only when you have zoomed in on the timeline.  It actually works reasonably well. You can scroll earlier and later in the schedule while zoomed in. The time labels on the slider are updated to show the current plot range.

4.1.3.
Target Viewer window

4.1.3.1 Target Viewer List

The Target Viewer is a multi-column list of the observation segment definitions along with any schedule information.  The first column is the unique observation number, the second column is a status field, and the remaining columns contain database fields.   The rows in the list can be sorted by clicking the left mouse button on the column heading.   Clicking again on the heading toggle the sort direction between ascending and descending.   The width of the columns can be adjusted by left-clicking on the seam between the headings and dragging. The order of the columns can be changed by right-click and dragging the column to the seam.  The column configuration can also be changed using the Configure Labels button.  The column configuration is saved in the TAKO session file so that it is retained between sessions.
Selecting a Target

A target can be selected in two ways.  One way is to click the left mouse button on an entry in the Target Viewer list.  Another way is to click the right mouse button over a scheduled snapshot on the "mainevents" timeline.  This will highlight the corresponding entry in the Target Viewer list and cause the timelines to be updated for that target.
4.1.3.2 Nudge

The Nudge feature allows the user to make small changes in the observation start time.  It is available when a scheduled observation is selected.  The buttons are self-explanatory.  The scale is set so that the left and right edges represent the begin time and end time of the "goodtime" that brackets the observation's start time.  

4.1.3.3 Target Selection

The Target Selection area is used to display a subset of the observation list in the Target Viewer list.  Determine a string of characters that characterizes the desired subset, type the string in the text entry box and press return.  (Note: This is a strict string match, not a regular expression.) TAKO displays only the entries that contain the string in any field of the displayed record.   Click on the Reset Selection button to show all the entries again.  This feature provides any easy way to display observation of a certain type, or all observations of a certain target ID. 

4.1.3.4 Configure Labels

Although the width and order of individual columns can be changing by dragging the mouse, the total width of the target record cannot be changed this way.   Another way to change the column width and order is to use the column configuration editor. Click the Configure Labels button to bring up the Configure Columns window.  The columns are displayed in their current order along with the current widths.  The user can then type in the desired widths in the entry boxes.  The order of the columns can be changed by clicking on the label of column and dragging it to the desired location.  Either right button or left button can be used to select and drag the column.  

Apply – updates the listbox so you can see what the changes look like,  The new values will be in effect for this session only unless you commit them.
Commit –  applies the order and width values and stores them in internal variables so they can be saved for use in future sessions.

Close – remove the window.  Any changes that have not been committed will not be saved.
Reset to Default – sets the order and width to default values

Revert to Committed – sets the order and width to the last committed values.  Note: if you revert, you must apply or commit before closing the window in order for the values to be used.
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Figure 4.1.3.
 
Configure Columns Window
4.1.4.
Info box window

Status messages are displayed in the Info box as TAKO does its processing. The messages are color coded:

· Black text is for routine informational messages. 

· Blue text is for warning messages – TAKO couldn't do something, but the user can recover

· Red text is for error messages –for hard errors such as not being able to open a file, also for Tcl errors

The messages written to the Info box are also written to the TAKO log file.

4.2.
 Target Database Editor

The Target Database Editor is used to change the scheduling window, the observation segment definition list, and the constraint definitions.  The menu item for Resources in not implemented. 

4.2.1.
Menus

The target database editor window has a menu bar.  The File menu deals with reading and writing files.  The Context, Observations, Constraints, and Resources menus give access to the editor panels for the various database records.  Help displays a window with brief instructions on the purpose of the menu bar.
4.2.1.1. File menu
The File menu provides access to input and output functions and is illustrated in Figure 4.2.1-1 
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Figure 4.2.1-1.
 Target Database Editor File Menu

Load Target DB  - select and load a target database file.  This is the same as Load ( Target DB in the main file menu.  This menu option is typically not used.

Import Targets – select and load observation segment observations from a comma-separated-value (CSV) format file.  See Input File Definitions section and Update Observation List section.
Update Schedule – updates the schedule based on current changes to the database.  If any changes were made to the ephemeris file name, constraint definitions, or some observation definition fields, this may result in all the snapshots of the current schedule being deleted.

Revert Database – changes the current database to the contents it had when it was last saved.  Any changes made in the editor session are lost.  This is equivalent to reloading the database file.

Save Target DB – Update the schedule and save the edited database values.  Performs the function of Update Schedule, then displays a file selection dialog.  Select Save to use the current filename.  Select Save As to save the database in a new name.  The recommended file name is presented.  You may use that name or enter a file name, then click on Save. 
Export Targets – Write the observation definitions to a CSV-formatted file.  This file can be imported by a spreadsheet or other planning tool.  This does not export the schedule or the constraint definition records.  
Database Report – This is the same as the Output ( Write Database Report function on the main menu.  It is repeated here for convenience.
Close – exit from the editor.  Updates the schedule as in the Update Schedule function. Then copies the database information to the TAKO scheduler data structures and closes the editor window.   Changes to the target database do not have to be saved in the editor.

They can be saved from the main menu.

4.2.1.2. Context

This menu as one menu item: Edit Context. This menu option  brings up the context editor panel which is described in Section 4.2.2.

4.2.1.3. Observations

Has one menu item: Edit Observations.  This menu option  brings up the observation editor panel which is described in Section 4.2.3.

4.2.1.4. Constraints

Has one menu item: Edit Constraints.  This menu option  brings up the constraint editor panel which is described in Section 4.2.4.

4.2.2.
Edit Context

The Edit Context panel allows the user to set the scheduling period, window of interest, and ephemeris file to be used for scheduling.   In the lower portion of the window, it  displays all of the database context including whether or not the PPST has been generated and the schedule state.

Enter the date for the new scheduling period.  Press the TAB key and the window start entry will be updated.  Adjust the duration and window of interest start time if necessary.  Click the Select File button to choose the most up-to-date ephemeris.  The files are listed in a selection dialog.  The name of  the file contains the range of times for which the file contains data. Select the ephemeris file that includes the start and end of the scheduling period and press the Enter key.

Click the Change button when you are done updating the context. The lower portion of the edit panel will be updated.  If you don't press Change button, the new entries will not be applied.
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Figure 4.2.2. 
Context edit panel

The database context consists of the following values:

Scheduler version: This is the version identifier for the software used to create the database file.  It is possible to read a database created by the prior software release.  Any differences in format are automatically updated.  Then the file can be saved in the current revision.  Older versions of the software might not be able to read database files from a newer version.

Schedule state:  This indicates the current scheduling state or phase.

Working: The schedule is still being developed. A PPST has not been generated.

Alternate: The schedule has been developed and a PPST is generated.  If the schedule needs to be changed either delete the PPST or save the database under a different name.

Approved:  The PPST was sent to the MOC for use in ATS load generation. Base the next scheduling session on this database. 

Heritage file:  This is the name of the approved database that this file is based on.  This is used to check scheduling continuity. If the heritage file is not the most recently approved database, TAKO will notify you and give you the choice to continue or not.

Timeline file: This is the name of the PPST file generated from the current schedule.  It is blank for Working databases.

Schedule start: This is the start time of the plot window.  It is displayed in date format and as Modified Julian Date (MJD).

Schedule duration:  This is the duration, in days, of the plot window

Window start:  This is the start time of the window of interest.  It is displayed in date format and as Modified Julian Date (MJD). Scheduling for this session affects only the window of interest. The time before the window of interest is protected. The PPST is generated for the window of interest only.

Window duration: This is the duration, in days, of the window of interest. 

Ephemeris file: This is the name of the currently selected spacecraft ephemeris file. The naming convention of the file shows the time range of the data.  The start and stop time of the schedule window must occur within that time range.

Ephemeris date:  This is the date stamp of the ephemeris file.  This was designed as a check that the file was not replaced.  This check has not been implemented in the software.

4.2.3.
Edit Observations 

The observation editor allows you to add, modify, or remove observation segment definitions in the target database. The observation segment definition editor panel shown in Figure 4.2.3 is made up of two sections:  the edit pane and the observation list.  
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Figure 4.2.3. 
Edit Observations panel

4.2.3.1
Edit Pane

The edit pane contains an entry for each field in the observation record and in the scheduling rules record.  It also show the scheduling status of an observation.  To modify the observation, select the observation from the definition list.  If the observation is scheduled, information is displayed in the Schedule Summary box. The list of snapshots can be viewed by selecting the View Snapshot List button. 
The fields are validated when you press TAB or Enter, and when you click on the Add or Change buttons. (The fields are not validated if you use the mouse to select a new field.)   

If the selected observation is scheduled, you must use Add when you change any fields that are used as parameters to the FOPPTREQUEST command:

· Target id

· Segment number

· Figure of merit (FoM)

· Right Ascension (RA)

· Declination

· Roll

· BAT instrument mode

· XRT instrument mode

· UVOT instrument mode

If the selected observation is not scheduled, you must use Add only when you change the Target id, segment number, RA or declination.

Most commonly, you will create a new definition based on an existing definition when a new roll angle is needed, when a new initial instrument mode is desired, when the observation segment has been completely scheduled, or when the two-day limit on an observation segment has occurred.  After you make the necessary changes in the parameters, you must change the segment number to the next available value (usually by adding 1).
Typically, the roll angle for the observation is specified by an external source, e.g., instrument reading.  Note: TAKO does not check that the roll value entered in the entry box is within the roll constraint (see Requirement MPS0210).. Otherwise, the Calc button next to the roll entry box can be used to compute a nominal roll angle that is within the roll angle constraint   When the user clicks the Calc button, a window is displayed that prompts for the time offset (Figure 4.2.3.1). The time offset is added to the start time of the schedule and the sun angle at this time is used in the roll angle computation. The roll angle is typically valid for 20 days, so the default roll time offset is 10 days to give the observation the longest window for a valid roll angle.  However, for some target geometries, the time offset should be less.  
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Figure 4.2.3.1.
 
Roll Angle Time Offset
Because the roll angles get "stale" as the sun angle changes over time, the roll angles for the fill-in targets need to be updated periodically.  These targets may be updated individually or by using the Update Roll for Fill-in button.  The other targets need to be updated only if their current roll angles violate the roll angle constraint.

The Change button is used to update parameters in an existing observation segment definition. If the observation is schedule, the parameters that affect the FOPPTREQUEST command parameters may not be changed. The fields that can be changed for a scheduled observation are  the fields in the Scheduling Rules section, the target name, target type, and comment fields.  Most commonly, you will want to change the duration in order to schedule additional snapshot for the observation.   Also, you may change the priority of an observation segment so that it is scheduled when you want it.  If the observation is not scheduled, any fields except the target id, segment, RA, and declination may be changed.  The target id and segment identify the observation.  If you change these, then by definition you have a new observation segment.
The Restore button restores all of the edit fields to the values they had originally.  It is equivalent to selecting the entry again.  After you click Add or Change, the values cannot be restored.
The Clear button sets all of the edit fields to default values.

The Delete button removes an observation segment definition from the database. It is enabled only for observations that have not been scheduled.  There is no "undelete" feature.  So don't delete an observation unless you mean it.

The Archive button also removes an observation segment definition from the database. It is enabled only for observations that are scheduled.  You may wish to archive observations that have been completely observed, or can no longer be scheduled due to constraints.  If the duration in the Schedule Rules area and the duration in the Schedule Summary area are equal (or close enough), then this target is completely scheduled. If the stop time of the scheduled snapshot in the past, then it is safe to archive the observation.  Archiving old observation cuts down on the clutter in the observation list.  Keeping the observation list short also slightly reduces the time it takes to autoschedule because the autoscheduler does not have to examine as many observations to determine what can be scheduled.

Scheduled observations are archived rather than merely deleted because we need to keep a list of assigned observation numbers.  This list is used, in conjunction with the observations in the current database, to ensure that observation numbers are not reused and that target IDs are not assigned to different locations.  There is no "unarchive" feature.

The definition list is a tabular list of the observation records in the database.  The sched_status field indicates whether the observation is scheduled or not.  To edit an existing observation segment definitions, select an entry in this list.

Table 4.2.3. Status Codes

	Status Value
	Short Name
	Description

	
	blank
	The observation is not scheduled

	t
	trailing 
	The observation starts before the window of interest and the entire observation is scheduled. 

	t p
	trailing, partial. 
	The observation starts before the window of interest and the observation is not completely scheduled.

	s
	scheduled
	The observation starts within the window of interest and the entire observation is scheduled. 

	s p
	scheduled, partial
	The observation starts within the window of interest and the observation is not completely scheduled.

	f
	future
	The observation starts after the window of interest and the entire observation is scheduled. *

	f p
	future, partial
	The observation starts after the window of interest and the entire observation is not completely scheduled.*

	* Having an observation start in the future is not normal.  This can happen only if you set the schedule time range earlier than your last planning period.  This is not recommended.  If you need to go back in time, it is best to unschedule the snapshots in the current period before going back. The main problem occurs when you advance the schedule times again. The remaining snapshots may interfere with the new observations that you scheduled.


4.2.3.2 Observation List

The observation list is a multi-column listbox similar to the Target Viewer.  It provides a tabular list the observation record fields and the schedule rules fields.  The operation of the multi-column listbox and the Configure Labels button is described in the section on the Target Viewer. The Configure Labels button can be used to change the order and width of the columns.  The first column and the last three columns may not be moved due to the needs of the program.  Changes to the label configuration will be saved to the database if you commit them.  If you just apply them, they will be in effect only during this session.
The additional buttons below the Observation List allow the user to update the roll angle of many observations at once.  
Update Roll for All – displays a dialog to prompt for the roll angle time offset.  This is the same value used with the Calc button. Then the roll angle for each unscheduled observation is updated, unless the target type contains the string "lockroll". If a scheduled observation is a fill-in target (target type=Fill-in), then a new observation segment is created and its roll is updated.
Update Roll for Fill-in - displays a dialog to prompt for the roll angle time offset.  Updates the roll angle for fill-in targets only. (target type=Fill-in) If the fill-in observation is scheduled, then a new observation segment is created and its roll is updated.  This ensures that the target database will always have a full set of fill-in targets available.
4.2.4.
Edit Constraints

The constraint definitions should rarely need to be changed.   Do not delete any of the delivered constraints. The roll, sunlimit, moonlimit, occult, and ramlimit constraints define basic scheduling requirements. These should not be changed without concurrence from the FOT. The saa constraint is used to compute ReqObsSecs and must always be output. Additional constraints, such as the time critical (TC) constraint, may be defined as needed to restrict scheduling during certain time periods.  The values for the constraint definition fields are defined in Appendix B.  

The editor can be used to create a new constraint definition, to change an existing definition, or to make a new constraint based on an existing definition. When creating a new constraint, type the field values into the appropriate text entries and press the Add button. To update a definition, select the definition from the window.  The editor pane entries will be populated will the current values. Make the desired changes and press the Add or Change button. 

A field value is validated when you press Tab or Enter.  Tab also advances the cursor to the next field. Selecting a new field with the mouse does not run the validation function for the field you left.  The validation functions are run again when the Add or Change button is clicked.  

The Add button is used when the Name or Targets fields are changed.  

The Change button is used to replace the existing definition with the changed values.

The Restore button is used to undo the changes made to the selected constraint.  It is identical to selecting the definition entry from the list again.

The Delete button is used to remove constraints.   You will typically remove out-of-date TC constraints. Do not delete any of the delivered constraints.
The Help button displays a brief description of the constraint definition field values.
The Configure Labels button can be used to change the order and width of the columns.  The first two columns may not be moved due to the needs of the program.  The Configure Labels button is described in detail in the Target Viewer section. Changes to the label configuration will be saved to the database if you commit them.  If you just apply them, they will be in effect only during this session.
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Figure 4.2.4. 
Constraint Definition Editor Panel

Appendix

A. Installation

This user guide assumes that TAKO has been installed.  Installation has three steps:

1.  Load the delivered software

2.  Populate the MOC file server directories (create them if necessary)

3.  Set up the SOT user account.

Details are given in the Installation Notes for the current build.  A summary is given here to help troubleshooting.

After installation, this is what the user should see:

1.  Load the delivered software

See that the TAKO software resides in /home/swiftins/MOC_current/moc/Tako

2.  Populate the MOC file server directories.
See that directories were created under /filesvr/ops_ mocfilesvr

See that TAKO configuration file (tako.init) is installed in the MOC file server directory, $FS_MOC_CONFIG.  Check that the TakoData keyword is set to the path for the TAKO data directory location ($HOME/TAKO.data).  

3.  Set up SOT user account.

a. 
The .profile file has been set up as follows:

export MOCFILESERVER=/filesvr/ops_mocfilesvr

export MOCINSTALLDIR=/home/swiftins/MOC_current/moc

export PATH=$PATH:$MOCINSTALLDIR/Tako/

. $MOCINSTALLDIR/config/mocenvrc  # set MOC environment

# full path of the base installation directory for TAKO

export TAKO=$MOCINSTALLDIR/Tako 

# full path of TAKO data directory

export TAKODATA=$HOME/TAKO.data  

alias runtako="$TAKO/bin/tako init=$FS_MOC_CONFIG/tako.init"

b.  
The TAKO data directory has been created.

       The TAKO data directory must contain these files:

SAA_Swift_default.txt        

blank.xbm                    

targ_fillins_DB.csv

defaultDB.tcl                

targ_swift_exercise_DB.tcl

disk.xbm                    

Appendix

B. Target Database

The target database is a file containing a list of short-term observations (called observation segments) and the constraints on those observations.  This list, or a subset of the list, is input to the scheduler.  Based on the defined constraints and scheduling guidelines, the scheduler breaks up the observation segments into snapshots and schedules them at appropriate times.  The resulting snapshot schedule is then stored in the target database. This allows continuity to be kept between the observation segment definitions and the resulting schedule.  

There will be many instances of the target database file over the life of the mission.  A new instance must be saved whenever a preplanned science timeline (PPST) is generated because the PPST references the target database that was used to create it.  A target database file is effectively frozen when a PPST is approved for load generation. An approved target database file is then used as the starting point for the next scheduling session, and the results must be saved in a new target database file.  The file of the approved target database file is stored in this new target database file to indicate the heritage of the file.

The initial observation segment definition entered by the science planner (user) includes:

· the target info (target id, segment number, target name)

· the type of observation (e.g., prime, calibration, fill-in point, survey), 

· FOM merit value and the instrument modes 

For the planning and scheduling task, we can expand the observation segment definition to include:

· the duration of the observation segment (requested integration time)

· scheduling priority
· snapshot duration limits

Start and stop time constraints are entered as a constraint definition.

After scheduling, the database holds this information for each scheduled observation:

· a list of scheduled snapshots 

· the scheduled duration

Each target database file will contain these types of records:

· Database id and configuration (context) 

· Observation segment definitions

· Scheduling rules

· Scheduling results summary

· Snapshots

· Constraint definitions

The target database file is a text file, but it is not easily interpreted by a human. The records defined below are logical descriptions rather than physical description.  They relate to how the database is displayed in the target database editor and in the database reports. The field numbers are given for reference purposes only. The physical description of the target database is in the TAKO Programmer Guide.

Filename convention:

The target database file name convention is:

      targ_string_DB.tcl

where string is any string that identifies the file.

The default file name offered in the Save As window will be

     targ_YYYYDDDHHMM_YYYDDDHHMM_VV_DB.tcl 

where YYYYDDDHHMM is a time stamp.  The first time is the schedule start time and the second time is the schedule stop time.

      VV is used to distinguish different files created for the same time range 

B.1
Context Record Fields

The target database context includes database identification and housekeeping fields.

	Field #
	Field Name
	Values
	Description

	1
	TAKO release number
	text
	TAKO release number, provided by the software when the file is created

	2
	Schedule start time 
	ITOS format time
	For display purposes.  The individual observations may have snapshots that occur before the Schedule start time

	3
	Schedule start time


	MJD
	

	4
	Schedule period length


	days (float)
	

	5
	Window of interest start time
	ITOS format time
	The start of the window of interest.  The end of the window of interest is always the same as the end of the schedule. 

	6
	Window of interest start time
	MJD
	

	7
	Window of interest duration
	days (float)
	

	8
	Schedule state
	Working 

Alternate

Approved
	"Working" is the default.

"Working" means this target database contains observation definitions and constraint definitions,  and may or may not have scheduled snapshots for the scheduling period.  It has not been used to create a PPST. The user is still working on the schedule for the period.

"Alternate" means a PPST was generated but not yet approved. Several alternate schedules may exist for a scheduling period.

"Approved" means that this is the alternate schedule that was sent to the MPS in the MOC.

	9
	Heritage database file
	Blank or 

full path name
	The approved target database file that this target database is derived from.  This helps maintain schedule continuity.  

	10
	PPST file name
	Blank or 

full path name
	PPST_YYYYDDDHHSS_YYYYDDDHHSS_vv.txt

The field is blank for Working files.

	11
	Ephemeris file name
	full path name
	STK_EPH_YYYYDDD_YYYYDDD_vv.txt

	12
	Ephemeris file date
	
	The creation time of the ephemeris file 

	
	
	
	

	
	
	
	


B.2
Observation Segment Definition Record Fields

The values for all fields except the observation number are provided by the user. The FOPPTREQUEST parameters are described in the Onboard Operational Messaging Interface Document. The valid range for Target ID and Segment are given in the SWIFT Observation Definition, 410.4-AGMT-0011.
	Field #
	Field Name
	Values
	Description

	1
	Observation number
	32-bit integer
	Unique number based on Target ID and Segment #.  This is the record key.

	2
	Target name
	text
	Common name of the target location. 

	3
	Observation Type
	text


	A label to classify observations.  The values are defined in the TAKO configuration file.  Examples: Calibration, Fill-in,

BAT Survey, GRB afterglow

	4
	Target ID
	24-bit integer
	FOPPTREQUEST parameter

	5
	Segment #
	8-bit integer 
	FOPPTREQUEST parameter

	7
	Figure of Merit
	
	FOPPTREQUEST parameter

	8
	RA
	
	FOPPTREQUEST parameter

	9
	Declination
	
	FOPPTREQUEST parameter

	10
	Roll
	
	FOPPTREQUEST parameter

	11
	BAT mode
	
	FOPPTREQUEST parameter

	12
	XRT mode
	
	FOPPTREQUEST parameter

	13
	UVOT mode
	
	FOPPTREQUEST parameter

	14
	Requested duration (integration time)
	seconds
	Observation duration; provided by user; seconds are used even though schedule is to the minute only.  

	15
	Comment field
	text
	Used to record PI, and other target info that is not needed for scheduling, but would be nice to know.

	
	
	
	


B.3
Scheduling Rules Record Fields

The scheduling rules record provides instructions to the scheduler. All the values for all fields except the observation number are provided by the user.

	Field #
	Field Name
	Values
	Description

	1
	Observation number
	
	Unique number based on Target ID and Segment #. Ties this record to its observation definition record.

	2


	Scheduling priority
	0-99
	The Autoscheduler can be configured to use this value to sort the observations prior to entering the scheduling loop.  Thus higher priority observations can be scheduled first.

	
	
	
	


	
	
	
	

	
	
	
	


	
	
	
	

	3
	Minimum snapshot duration
	seconds
	The scheduler will not schedule a snapshot that is shorter than the minimum.

	4
	Maximum snapshot duration
	seconds
	The scheduler will not schedule a snapshot that is longer than the maximum.

	
	

	
	


B.4
Scheduling Results Record Fields

This record is a summary of the snapshot records. All values are produced by the scheduler.
	Field #
	Field Name
	Values
	Description

	1
	Observation number
	
	Unique number based on Target ID and Segment #.  Ties this record to its observation definition record.

	2
	Scheduled duration
	seconds
	Amount of time that could be scheduled  (sum of scheduled snapshot durations). When Scheduled duration is equal to the requested duration, then no more snapshots will be scheduled. This value does not include the estimated maneuvering time or  time in SAA.

	3
	Start time
	UTC date/time
	Scheduled start of first snapshot

	4
	End time
	UTC date/time
	Scheduled end of last snapshot

	5
	Snapshot count
	positive integer
	Number of snapshots scheduled.  

	
	
	
	


B.5
Snapshot List Record Fields

All values are produced by the scheduler.
	Field #
	Field Name
	Values
	Description

	1
	Observation number
	
	Unique number based on Target ID and Segment #.  Ties the snapshot list to its observation definition record.

	2 – n
	Snapshot record
	See Snapshot Record Fields
	Snapshot records for this observation.  The list is empty when the observation has not been scheduled.


B.6
Snapshot Record Fields

The scheduler will create one record for each scheduled snapshot.  Each snapshot record corresponds with an FOPPTREQUEST command. The snapshot records for one observation are grouped inside a Snapshot List record. These values are set by the scheduler.

	Field #
	Field Name
	Values
	Description

	1
	Snapshot number
	positive integer
	Sequence number of the snap shot. Used by the scheduler to uniquely identify the snapshot. 



	2
	Scheduled start time
	UTC date/time
	This will be the time that the ATS will execute the FOPPTREQUEST command. 



	3
	Scheduled end time
	UTC date/time
	

	4
	Scheduled duration
	seconds
	The snapshot duration is End time – Start time – Slew time – Time in SAA. The slew time and time in SAA are deducted because this time is not counted toward completing the requested observation duration.  Also used as the ReqObsSecs value for the FOPPTREQUEST command associated with this snapshot.



	5


	Schedule priority
	floating point
	From the Scheduling Rules for this observation.



	6
	Slew time
	seconds
	Estimated slew time from previous target to this target;



	7
	Time in SAA
	seconds
	Amount of time this snapshot occurs within the South Atlantic Anomaly, but NOT during a maneuver. 



	8
	Reschedule flag
	0, 1, 2
	Rescheduling flag:

0 = allow snapshot to be moved/deleted during automated scheduling

1 = don't move during automated scheduling, this was placed by user.  Can be unscheduled only by user.

2 = snapshot is frozen for other reasons. Don't let user move it either. Cannot unschedule.


B.7
Constraint Definition Record Fields

The record layout is designed to be compatible with legacy TAKO constraint data structure. These values are provided by the user. Also, TAKO is delivered with a default database and contains the basic Visibility and Safety constraint definitions for Swift.  These basic constraint definitions are discussed in Appendix C.

	Field #
	Field Name
	Values
	Description

	1
	Constraint name
	text
	Plot label for the constraint (no blanks in name)

	2


	Targets
	"all",

"global", or

list of observation numbers
	Targets that this constraint applies to

	3


	Debit
	<blank>

"info",

"NULL", 

"goodtime"

"badtime"
	List of resources that this constraint applies to, e.g. goodtime.

When the value is <blank>, "info", or "NULL" then the constraint is computed for information only.

"goodtime" adds 1 to the goodtime resource when the constraint is true

"badtime" subtracts 1 from the goodtime resource.

Other resources could be named here, but the capability is not implemented.

	4
	Type
	"derived",

"coded"

"derived coded",

"region",

"tc"
	See the section on Constraint Specification below.

	5
	Specification
	
	See the section on Constraint Specification below.

	6
	Plot Type
	"step"

"range"
	Plot Type = "step", produces an integer step histograph plot

Plot Type = "range", produces a x,y plot of the constraint.  x is time and y is the constraint value.

	7
	Ymin
	floating point,

<blank>, or "NULL"
	minimum value for the y plot axis.

<blank> or "NULL" causes the plot to be rescaled each time a value is plotted.

	8
	Ymax
	floating point,

<blank>, or "NULL"
	maximum value for the y plot axis

<blank> or "NULL" causes the plot to be rescaled each time a value is plotted.

	9
	Ephemeris
	text,

<blank>, or "NULL"
	Optional. Ephemeris data name. Ephemeris of another object needed to compute this constraint. None of the constraints defined for Swift use this field

	10
	Boresight
	<blank>, or "NULL"
	Optional. coordinated of non-coaligned boresight. None of the constraints defined for Swift use this field

	11
	Display?
	"yes", or "no", or a positive integer
	Display = "yes" or  > 0, constraint timeline is plotted.  A numeric value indicates the display order of the timelines, where 1 is the bottom of the POW area and higher numbers are at the top. (e.g., mainevents is 99, goodtime is 95.) "yes" is interpreted as a display order of 1.  If two constraints have the same order number, the plot system decides the order.

Display = "no" or 0, constraint timeline is not plotted, but the data is computed and is available to be used to compute other constraints.

	12
	Output?
	"no", 0

"yes", 1


	How to output the constraint values to the PPST file.

"no" – do not output

"yes" – all values

	13
	Comments
	text
	Optional notes about the constraint definition


Constraint Type and Specification

When Type is "derived", the constraint values are computed from an expression involving another constraint. The Specification for a "derived" constraint is an expression in terms of other constraints and /or subroutines. For example, a specification of "suntgtang < 30.0" causes a constraint curve to be generated that is 1 when the value of the suntgtang constraint is less than 30 degrees at the sampled time. The suntgtang constraint is specified in another constraint definition record.

When Type is "coded", the constraint values are computed in a subroutine. The Specification for a "coded" constraint is the name of a subroutine to be called to determine the constraint value. For example, a specification of "xtesaa" calls a subroutine named xtesaa to compute the constraint curve.  The currently implemented subroutines are described in Appendix C.

When Type is "derived coded", the constraint value is computed based on a derived data value which is then passed to a subroutine. The Specification for a "derived coded" constraint is the name of the coded routine followed by the names of all data items to pass to it.  For example, a specification of "xteroll sunangle" calls the xteroll subroutine and passes the sunangle constraint value as the argument.  

When Type is "region", the constraint value is based on the spacecraft location in orbit (latitude, longitude) The Specification for a "region" constraint is:

· a file name, (file=pathname) 

· an internal precoded definition (internal=definition)

If the specification is a file name, the file contains the coordinates, one set per line.  The coordinates may be two-dimensional (long/lat) or three-dimensional (plus altitude)

If the specification is internal, the definition is the name of a subroutine that when called will determine if the spacecraft location is in the region. The available subroutines are described in Appendix C.

When Type is "tc", the constraint value is based on a time range. (tc stands for time critical). The Specification for a Time Critical Constraint  is a "window" expression, a "phase" expression, or a sequence of expressions combined with the AND or && operator.  

TC window expression 

The absolute window time constraint defines a window during which the constraint value is true.  It is specified in this format:

window start stop

where start  is the absolute start time of the time window


stop   is the absolute stop time of the time window

Times can be entered in ITOS format (YYYY-DDD-HH:MM:SS) or MJD.

Example 1:

window 2003-100-00:00:00 2003-100-23:59:59

The constraint is true for all of day 100 and is false otherwise.

Example 2:

 window 2003-101-00:00:00 2003-101-23:59:59 AND

 window 2003-102-12:00:00 2003-102-13:30:00

As shown in Figure B.7-1, the constraint is true for all of day 101 and on day 102 from noon to one thirty, and is false otherwise.
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Figure B.7-1.
TC Using AND

TC Phase Expression

The phase constraint defines a series of time windows at regular intervals during which the constraint value is true.  It is specified in this format:

phase epoch period start_offset stop_offset begin_phase end_phase

where epoch


origin time of the phase
period 
phase period in days

start_offset
can be specified in two formats:

1) 
ddd/hh:mm offset from the start of the phase where

ddd is days

hh is hours

mm is minutes

ddd/ is optional and default to 0

2) fraction of the phase period to elapse before constraint becomes true 
stop_offset 
fraction of the phase period to elapse before constraint becomes false
begin_phase 
beginning of the time range affected by the defined phase curve.  The parameter is optional.  If omitted the begin_phase defaults to beginning of the scheduling window
end_phase
end of the time range affected by the defined phase curve, The parameter is optional.  If omitted the end_phase defaults to the end of the scheduling window.
epoch, begin_phase, and end_phase times can be entered in ITOS format (YYYY-DDD-HH:MM:SS) or MJD.

Example 3: 

phase 2003-100-00:00:00  1.0 12:00 13:00  

epoch=2003-100-00:00:00

period = 1 day

start_offset = 12:00

stop_offset = 13:00

begin_phase and end_phase default to the schedule period boundaries.

This specification results in a curve where the constraint is true for one hour each day from noon to one.  See Figure B.7-2.  Note that the curve extends back in time from the epoch as well as forward.

[image: image26.png]n n





Figure B.7-2. 
TC Constraint Example 3

Example 4:

phase 2003-100-00:00:00  7.0 001/12:00 002/13:00  2003-100-00:00:00 2003-130-23:59:59

epoch=2003-100-00:00:00

period = 7 days

start_offset = 001/12:00

stop_offset = 002/13:00

begin_phase =2003-100-00:00:00

end_phase =2003-130-23:59:59

This specification results in a curve illustrated in Figure B.7-3 where the constraint is true once a week from the second day at noon to the third day at one.  The phase is computed only for the 30 days after 2003-100-00:00:00.  
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Figure B.7-3. 
TC Constraint Example 4

Example 5:

phase 52742 0.1 0.4 0.6 52740 52743

This specification is given in the legacy TAKO format. In the time range 52740.0 to 52743.0, it creates a phase curve where, for each 1/10th of a day period (0.1) going both forward and backward in the timeline from 52742.0, the constraint is true starting at 40% of period and is false again after 60% of the period. The resulting curve is illustrated in Figure B.7-4. 
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Figure B.7-4.
 TC Constraint Example 5

Appendix

C. Constraint Definitions for Swift

C.1
Sun Angle

This constraint computes the angle at each point in the schedule period between the sun and the target relative to the center of the earth.  It is used by the Sun Limit constraint.  The constraint is computed for all targets. The constraint values are computed by the suntgtangle subroutine. Do not delete this constraint. The plot doesn't need to be displayed, so the Display field may be modified to suppress the plot if desired.  

Definition as delivered:

	Field
	Value

	Name 
	suntgtang  

	Targets 
	all

	Debit 
	info

	Type 
	coded

	Specification 
	suntgtangle

	Output 
	no

	Display 
	10

	Step/Range 
	range

	Ymin 
	0

	Ymax 
	200

	Comments 
	angle between sun and target

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.2
Moon Angle

This constraint computes the angle, at each point in the schedule period, between the moon and the target relative to the center of the earth.  It is used by the Moon Limit constraint. The constraint is computed for all targets.  The constraint values are computed by the moontgtangle subroutine. Do not delete this constraint. The plot doesn't need to be displayed, so the Display field may be modified to suppress the plot if desired.  

Definition as delivered:

	Field
	Value

	Name 
	moonang  

	Targets 
	all

	Debit 
	info

	Type 
	coded

	Specification 
	moontgtangle

	Output 
	no

	Display 
	9

	Step/Range 
	range

	Ymin 
	0

	Ymax 
	200

	Comments 
	angle between moon and target

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.3
Ram Angle

This constraint computes the angle between the spacecraft's velocity vector and the target at each point in the schedule period.  It is used by the Ram Limit constraint. The constraint is computed for all targets.  The constraint values are computed by the ramtgtangle subroutine. Do not delete this constraint. The plot doesn't need to be displayed, so the Display field may be modified to suppress the plot if desired.  

Definition as delivered:

	Field
	Value

	Name 
	ramangle  

	Targets 
	all

	Debit 
	info

	Type 
	coded

	Specification 
	ramtgtangle

	Output 
	no

	Display 
	15

	Step/Range 
	range

	Ymin 
	0

	Ymax 
	200

	Comments 
	angle between velocity vector and target

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.4
Sun Limit

This constraint determines whether or not the sun angle limit has been exceeded at each point in the schedule period. It uses the values computed by the Sun Angle constraint and compares each one with the limit.  The values of this constraint are either 0 (no violation) or 1 (violation). The times when the constraint is violated are plotted in red.  The "badtime" resource is debited when the sun angle is less than or equal to the limit. This also causes the "goodtime" value to be false, so the target will not be scheduled while the constraint is violated.  

The constraint is computed for all targets. Do not delete this constraint since it is needed to fulfill Requirement MPS0150.  The limit (currently 50 degrees) may be changed with concurrence of the FOT if the delivered limit value is no longer valid.  

Definition as delivered:

	Field
	Value

	Name 
	sunlimit 

	Targets 
	all

	Debit 
	badtime

	Type 
	derived

	Specification 
	suntgtang <= 50.0

	Output 
	no

	Display 
	70

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	2

	Comments 
	target vs. sun limit

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.5
Moon Limit

This constraint determines whether or not the moon angle limit has been exceeded at each point in the schedule period. It uses the values computed by the Moon Angle constraint and compares each one with the limit.  The values of this constraint are either 0 (no violation) or 1 (violation). The times when the constraint is violated are plotted in red.  The "badtime" resource is debited when the moon angle is less than or equal to the limit. This also causes the "goodtime" value to be false, so the target will not be scheduled while the constraint is violated.  

The constraint definition is applicable to all targets. Do not delete this constraint since it is needed to fulfill Requirement MPS0150.  The limit (currently 35 degrees) may be changed with concurrence of the FOT if the delivered limit value is no longer valid.  

Definition as delivered:

	Field
	Value

	Name 
	moonlimit 

	Targets 
	all

	Debit 
	badtime

	Type 
	derived

	Specification 
	moonang < 35.0

	Output 
	no

	Display 
	65

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	2

	Comments 
	target vs. moon limit

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.6
Ram Limit

This constraint determines whether or not the ram angle limit has been exceeded at each point in the schedule period. It uses the values computed by the Ram Angle constraint and compares each one with the limit. The constraint is violated if the NFI instruments are pointed at a target that is within 10 degrees of the spacecraft velocity vector.  The values of this constraint are either 0 (no violation) or 1 (violation). The times when the constraint is violated are plotted in red.  The "badtime" resource is debited when the ram angle is less than or equal to the limit. This also causes the "goodtime" value to be false, so the target will not be scheduled while the constraint is violated.  

The constraint definition is applicable to all targets. Do not delete this constraint since it is needed to fulfill Requirement MPS0150.  The limit (currently 10 degrees) may be changed with concurrence of the FOT if the delivered limit value is no longer valid.  

Definition as delivered:

	Field
	Value

	Name 
	ramlimit 

	Targets 
	all

	Debit 
	badtime

	Type 
	derived

	Specification 
	ramangle < 10.0

	Output 
	no

	Display 
	75

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	2

	Comments 
	target vs. ram limit

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.7
Occult

This constraint determines whether or not, at each point in the schedule period, the target is within 30 degrees of the earth's limb.  The values of this constraint are either 0 (no violation - outside of 30 degrees) or 1 (violation within 30 degrees). The times when the constraint is violated are plotted in red.  The "badtime" resource is debited when the target is within in the limit. This also causes the "goodtime" value to be false, so the target will not be scheduled while the constraint is violated.  

The constraint definition is applicable to all targets. Do not delete this constraint since it is needed to fulfill Requirement MPS0150.  The limit (currently 30 degrees) may be changed with concurrence of the FOT if the delivered limit value is no longer valid.  

Definition as delivered:

	Field
	Value

	Name 
	occult

	Targets 
	all

	Debit 
	badtime

	Type 
	coded

	Specification 
	occult 30.0

	Output 
	no

	Display 
	50

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	151

	Comments 
	occultation 30 degrees

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.8
Roll Angle

This constraint determines whether or not, at each point in the schedule period, the spacecraft's roll angle when pointed at the target is such that the Sun vector is within 9.5 degrees of the XZ plane in the Z+ direction.  The values of this constraint are either 0 (no violation – within 9.5 degrees in Z+) or 1 (violation – outside of 9.5 degrees in Z+). The times when the constraint is violated are plotted in red.  The "badtime" resource is debited when the target is within in the limit. This also causes the "goodtime" value to be false, so the target will not be scheduled while the constraint is violated.  

The constraint definition is applicable to all targets. Do not delete this constraint since it is needed to fulfill Requirement MPS0150.  The limit (currently 9.5 degrees) may be changed with concurrence of the FOT if the delivered limit value is no longer valid.  The delivered value is less than the defined roll angle limit of 10 degrees in order to add a safety margin.

Definition as delivered:

	Field
	Value

	Name 
	roll

	Targets 
	all

	Debit 
	badtime

	Type 
	coded

	Specification 
	rollsun 9.5

	Output 
	no

	Display 
	45

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	151

	Comments 
	sun vector in/out of  9.5 deg range of XZ plane

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.9.
SAA

This constraint computes whether or not, at each point in the schedule period, the spacecraft is over the South Atlantic Anomaly region.  The values of this constraint are either 0 (not in SAA) or 100 (in SAA). Do not delete this constraint. It is an "info" constraint because it is not used to determine a target's "goodtime".  However, the time in SAA is determined from this constraint.  It is used to compute one of the PPST record parameters.  The Output parameter must remain set to 1 so that the SAA event is output to the PPST for use by the MOC software. The constraint definition is a global constraint because its values are not dependent upon the selected target.  

The file indicated by the Specification defines the SAA region.  This filename may be changed as necessary for seasonal changes in the SAA polygon or when more accurate coordinates for the SAA polygon are obtained through the life of the mission. The format of this file is described in Section 2.

Definition as delivered:

	Field
	Value

	Name 
	saa

	Targets 
	global

	Debit 
	info

	Type 
	coded

	Specification 
	saa file=$TAKODATA/SAA_Swift_default.txt

	Output 
	1

	Display 
	85

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	100

	Comments 
	<blank>

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.10
Orbit

This constraint indicates the time of the ascending node of each orbit during the scheduling period.  It is an "info" constraint because it is not used to determine a target's "goodtime".  The constraint definition is a global constraint because its values are not dependent upon the selected target.  This constraint is provided for reference and it may be deleted without affecting scheduling if it is not useful.

Definition as delivered:

	Field
	Value

	Name 
	orbit

	Targets 
	global

	Debit 
	info

	Type 
	coded

	Specification 
	orbitdata

	Output 
	no

	Display 
	1

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	2

	Comments 
	<blank>

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.11
TC window 

This constraint definition is provided as an example of a time critical constraint using the window specification.  It may be modified or deleted as desired.

Definition as delivered:

	Field
	Value

	Name 
	TCwindow

	Targets 
	global

	Debit 
	info

	Type 
	tc

	Specification 
	window 2003-001-00:00:00 2003-001-23:59:59

	Output 
	0

	Display 
	5

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	2

	Comments 
	time critical window

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.12
TC phase

This constraint definition is provided as an example of a time critical constraint using the phase specification.  It may be modified or deleted as desired.

Definition as delivered:

	Field
	Value

	Name 
	TC

	Targets 
	33554463,33554445

	Debit 
	info

	Type 
	tc

	Specification 
	phase 2003-001-00:00:00 0.1 00:30 00:40

	Output 
	0

	Display 
	6

	Step/Range 
	step

	Ymin 
	0

	Ymax 
	2

	Comments 
	time critical window

	Ephemeris 
	<blank>

	Boresight 
	<blank>


C.13
Internal subroutines

Functions available in Release 3 are listed in Table C.13-1 (bold indicates it is used in the delivered constraints): 

Table C.13-1
Constraint subroutines

	Functions
	Description

	occult 
	Expects one argument: angle in degrees from the earth limb

	roll 
	

	lineofsight 
	

	Sat2SatLOS 
	

	anglebetween 
	

	sunangle 
	

	intsunangle 
	

	saabrazil 
	

	saa 
	

	goodtime 
	

	xteroll 
	

	suntgtangle 
	No arguments. Computes the angle between the target and the sun center.

	moontgtangle 
	No arguments. Computes the angle between the target and the moon center.

	ramtgtangle 
	No arguments. Computes the angle between the target and spacecraft velocity vector.

	orbitdata 
	No arguments.

	rollsun
	Expects one argument: angle in degrees


Appendix

D. Messages and Error Recovery

	Message Text
	Severity
	Cause and Recovery

	EphemDir is not a directory. Correct the EphemDir entry in tako.init

where EphemDir is the EphemDir keyword's value


	warning
	Cause: The value given in tako.init for the EphemDir keyword is not a directory.

Recovery: Correct the value of EphemDir and restart TAKO.



	EphemFile could not be loaded.  Load the correct ephemeris file.

where EphemFile is the name of the selected ephemeris file
	error
	Cause: See terminal window for details.

Recovery:  If the cause is that the time range of the ephemeris does not contain the schedule period, then adjust the schedule period or choose another ephemeris.

Other errors include file format errors.  Verify that the selected file matches the expected format.



	EphemFile does not exist or is not readable.

where EphemFile is the name of the selected ephemeris file


	error
	Recovery: Check that file exists and has read permission for the user account.

	Filename passed to ingestCSV is empty.

where Filename is the selected filename
	error
	Cause: User selected a Target CSV import file that is zero length file

Recovery: Choose another file


	Item is not defined as an environment variable

where Item is a user-supplied string
	warning
	Cause:  User entered an undefined environment variable as part of a file name.  This could happen in the tako.init file or in constraint definitions.

Recovery:  Correct the entry.



	Obs_num can't be scheduled at that time (will deplete Type resource). Try after: Time  

where Obs_num is the observation number
Type is the resource type
Time is the suggested start time

	warning
	Cause: Scheduling at the clicked-on time will deplete a resource (slew) 

Recovery: schedule the observation at another time, or schedule another observation here that will not cause the total slew angle per orbit to exceed the limit



	Obs_num can't be scheduled at the chosen start time, Time.  It is not during a good time.

 where Obs_num is the observation number
Time is the observation start time

	warning
	Cause: User clicked at a time that was not during the observation's good time.

Recovery: Try again. Click inside the good time period.



	Obs_num can't be scheduled at the chosen start time, Time. Snapshot would be too short.

where Obs_num is the observation number
Time is the observation start time
	warning
	Cause: User attempted to schedule the observation and the snapshot can't be placed in the available gap because the gap is shorter than the snapshot minimum for the observation. 
Recovery: Schedule elsewhere, or modify the SSmin field of the observation.



	Obs_num exists in the current database.  Import will not replace an existing entry.

where Obs_num is the observation number
	warning
	Cause: The import record contains the same target id and segment as an existing observation in the target database.

Recovery: If you want to include this record in the target database,  Update the segment number in this record and import the file again.



	Obs_num exists in the target ID archive.  Import will not import a used observation number.

where Obs_num is the observation number

	warning
	Cause: The import record contains the same target id and segment as an archived observation. 

Recovery: We are not allow to reuse the  target id/segment of a scheduled observation. If you want to include this record in the target database,  Update the segment number in this record and import again.



	Obs_num not added. Msg 

where Obs_num is the observation number

Msg is the error text
	warning
	Cause: The import record was not added for stated reason.

Recovery:  Correct the record and import the file again.



	TakoData is not a directory. Correct the TakoData entry in tako.init

where TakoData is the TakoData keyword's value


	warning
	Cause: The value given in tako.init for the TakoData keyword is not a directory.

Recovery: Correct the value of TakoData and restart TAKO.

	Cannot delete an approved PPST  
	info
	Cause: User attempted to delete the PPST for an Approved database.  You can't delete the PPST once it has been sent to the MOC.

Recovery: If you want to replace the PPST, you must save the database under a new name.  Since the new database is a working database, you can reschedule and create a new PPST for the same time period.



	Cannot find region file Filename!  Error!

where Filename is the value of the file parameter in the region constraint specification
	error
	Cause: A region constraint specification contained a file name that does not exist in $TAKODATA. This constraint definition is ignored, processing continues with other constraint definitions.  

Recovery: Correct the filename or place the file in $TAKODATA



	Cannot fit at Time (not enough Type resource) 

where Time is the observation start time
Type is the resource type
	warning
	Cause: Scheduling an observation at that time will deplete a resource. For Swift, slew is the only resource defined.

Recovery: schedule the observation at another time, or schedule another observation here that will not cause the total slew angle per orbit to exceed the limit.



	Cannot save Target database - Status 

where Status is an error message
	error
	Cause: The target DB file could not be saved for the reason stated by Status.  Usually caused by a directory not having write permission for the user. Rarely, disk system is full.

Recovery: Check the write permission of the directory. Make sure you were saving to the correct directory.  System administrator may need to help.



	Can't ingest line LineNum due to errors listed above.

where LineNum is the line number of the record that contained the error
	error
	Cause: A record in the Target Import file (CSV) contained an error and was not imported.  The specific error was printed in previous messages.  



	Can't schedule here.  Gap (Gap) < Min. Snapshot (SSMinDur)

where Gap is the size of the unscheduled time span

SSMinDur is the minimum snapshot duration for this observation

	warning
	Cause: User attempted to schedule the observation and the snapshot wouldn't fit in the available gap because the gap is shorter than the snapshot minimum for the observation. 

Recovery: Schedule elsewhere, or modify the SSmin field of the observation.



	Class Class not known, could not initialize timeline"

where Class is a string
	warning
	Report a software anomaly providing the target database file name and the Tako log file name.  Slew resource may not show correct usage, but processing can continue.



	Config file contains unprocessed keyword: Key  

where Key is a string that TAKO thought was a keyword
	warning
	Cause: While processing the configuration file (tako.init), TAKO found a keyword that it didn't have any processing defined for. 

Recovery: Make sure to spell keywords correctly.  Check the tako.init file description for expected keywords.  TAKO can continue to run, but the results might not be as expected.


	debitResource:  getEventIndex did not return a valid index, slew timeline may be corrupt  
	warning
	Report a software anomaly providing the target database file name and the Tako log file name.  Slew resource may not show correct usage, but processing can continue.



	Error!  No region map given/ loaded for ID!

where ID is the internal constraint id. The first part of the id is the constraint name and target.
	error
	Indicates an error in the specification for region constraint.

Cause: A region map (file or internal parameters) was not provided in the specification for a region type constraint. Recovery: Check the syntax of the specification for the constraint definition of ID. See Appendices.



	Failed to open the export file: ExportFile

where ExportFile is the name of the report file
	error
	Cause: TakoData was set to a directory that could not be written to or doesn't exist.  Or, the file system is full.

Recovery: Check file system disk usage and  TakoData directory permissions.

	Failed to open the report file: ReportFile  

where ReportFile is the name of the report file
	error
	Cause: TakoData was set to a directory that could not be written to or doesn't exist.  Or, the file system is full.

Recovery: Check file system disk usage and  TakoData directory permissions.



	Global constraint: Key, input file: File does not exist, default values used.

where File is the value of the file parameter in the coded constraint specification

Key is the constraint name
	error
	Cause: In the specification for a coded type constraint, the filename in the file parameter does not exist, default values, e.g., the default SAA polygon will be used and processing continues but it may not produce the constraint that you want. This message is generated when the wrong file name is entered for the saa constraint. 

Recovery: Correct the file parameter in the specification for the constraint named Key.  



	Global constraints cannot be regenerated until an ephemeris file is chosen. 
	warning
	Cause: Schedule period was advanced to outside of the current ephemeris data time range.  

Recovery: Select an ephemeris file for the correct time range.



	Invalid specification for ID: spec
where ID is the internal constraint id. The first part of the id is the constraint name and target.

spec is the constraint specification field in error


	error
	Cause: Specification for a region constraint did not contain internal or file parameter. Check the syntax of the constraint definition ID.



	MasterPPSThistory value, Value, must be an integer < 400. Using default 7

where Value is the provided value   


	warning
	Cause:  In tako.init, the MasterPPSThistory value must be a number < 400

Recovery: Enter the correct value in tako.init and restart TAKO.  Refer to the tako.init description.



	No PPST file exists for a Working database


	info
	User selected Delete PPST menu for a Working database.  A Working database, by definition, does not have a PPST file.



	No resolution specified, using 1-minute bins as a default  
	warning
	Cause: Accuracy keyword is missing from tako.init.   

Recovery: TAKO will run properly, but the tako.init file should explicitly set 1 minute resolution.  



	No rough resolution specified, using 1-day bins as a default   
	warning
	Cause: Rough_Resolution keyword is missing from tako.init. 

Recovery: This keyword is required for TAKO to run correctly. Refer to the tako.init input file description.   



	Not permitted to reschedule Obs_num

where Obs_num is the observation number  
	warning
	This observation's schedule is locked. You may not move the start time.



	Note-- can't be scheduled at the chosen start time,  Time. Snapshot would be too short. 

where Time is the selected start time
	warning
	Cause: A snapshot starting at the chosen time would be too short. 

Recovery: Start the observation elsewhere, or modify the SSmin (snapshot minimum duration) field.



	Obsolete Target Database file: TargetDB

 where TargetDB is the target database filename


	warning
	Cause: the heritage file is not the most recently approved target database.  See prior messages in the log for details.  

Recovery: In normal operations, do not use this database, load the correct one. In a special situation, you may use this database only if you are certain that the timeline generated by this database will not cause constraint violations with respect to the previous ATS loads.



	Observation ObsNum ends after the chosen time.

where Obs_num is the observation number
	warning
	Cause: This happens when there are snapshots scheduled in the future beyond the window of interest.  i.e., the start time was moved earlier than the scheduled observation.

Recovery: None



	Only Count of Length required data files are accessible.  Exiting TAKO.

where Count is the number of files TAKO could read

Length is the number of files TAKO expects.
  
	error
	Cause: Some or all of the required input files were missing.  

Recovery: Either correct the TakoData value or copy the missing files from $TAKO/lib/data into the "TakoData" directory.



	Optional_Zoom_Type was invalid.  Using default: 0  
	warning
	Cause: Invalid value entered for Optional_Zoom_Type in tako.init.  The Value must be number, or "two" for two-level zoom.



	readDB: file version, DB_version, doesn't match application version, Tako_version
where  DB_version is the TAKO version when the database file was saved

Tako_version is the version of TAKO currently running


	warning
	Target DB was created with older version of TAKO. TAKO will attempt to update the database for the new version.  Save the database to keep the updates.

	Required data file, File, is not readable or doesn't exist.   

where File is the file name
	error
	Cause: This file must exist in the directory indicated in TakoData configuration keyword.  TAKO cannot run without it.

Recovery: Either correct the TakoData value or copy the missing files from $TAKO/lib/data into the "TakoData" directory.



	Roll angle not updated for Obs_num type TargetType.  Segment number would be invalid.

where Obs_num is the observation number

TargetType is the target type, usually "Fill-in"
	warning
	Cause:  When doing a batch roll angle update in the observation editor, a fill-in target ran out of segments (>254)

Recovery: Create a copy of this observation, change the target id and set the segment to 1.



	Rough resolution must be an numeric value, in units of minutes.  


	error
	Recovery: Don't change the value of  Rough resolution in tako.init



	Save Target DB first. Current schedule and observation definitions must be saved before creating a PPST
	info
	Recover: used Save or Save As to save the current schedule, observation definitions and constraint definitions.  The PPST name will be saved in the target database after it is generated, so TAKO wants to make sure the current target DB file is the one you want to use.



	Setting continuity window size to 1
	warning
	Cause: The value of the Continuity keyword in the TAKO configuration file was invalid.  It was set to 1 day as a default. TAKO can run with this value if desired.

Recovery: Correct the value of Continuity keyword. See tako.init description.



	Setting default maximum snapshot duration to 2400  
	warning
	Cause: The value of the MaxSSduration keyword in the TAKO configuration file was invalid.  It was set to 40 minutes as a default. TAKO can run with this value if desired.

Recovery: Correct the value of MaxSSduration keyword. See tako.init description



	Snapshot minimum duration, SSmin, is greater than the maximum duration, SSmax

where SSmin is the value of the minimum snapshot length field

SSmax  is the value of the maximum snapshot length field


	error
	Error in a CSV import record.

Cause: error in snapshot duration max or min in this record. The record number listed in a last error message.

Recovery:  Correct the values of the snapshot maximum and minimum fields in the indicated record of the CSV file you were importing.  Import the file again. 



	Target cannot be scheduled at Time. Must be in the window of interest winstart to winstop. 

where Time is the selected start time

winstart is the time of the start of the window of interest

winstop is the time of the end of the window of interest


	warning
	Cause: user clicked on timeline outside of window of interest.

	Target Type 'Type' is not in current target type list. Update list or change type.

where Type is a string

	warning
	Cause:  This can happen when the database report is generated. The database contains an observation whose type is not in the current list of valid Target Types (see tako.init) The observation was created when the Target Type list was different than it is now.  

Recovery: Processing will continue. User may wish to bring the observation's Target Type up-to-date, or to add the type to the list. However, there is no problem with leaving it as is.



	That time is occupied.  Try after Time 

where Time is the selected start time
	warning
	Cause: User attempted to schedule an observation (via left-button click) where another observation's snapshot is scheduled.

Recovery: Click on some other place on the timeline.



	The Field value is missing

where Field is the field name
	warning
	Cause:  A CSV import record is missing a required field.  This record is skipped and the other records in the file are be processed.

Recovery:  Correct the CSV file you were importing. Refer to the CSV file format. Import the file again.



	The value for RollTime invalid (Value).  Using default 10

where Value is the provided value

	warning
	Cause: The tako.init file had a bad value for RollTime.  TAKO can run with the default value if that is desired.
Recovery: See tako.init description for valid values. Correct the tako.init file and restart TAKO.

	The value for SchedDoneThreshold invalid (Value).  Using default 2

where Value is the provided value


	warning
	Cause: The tako.init file had a bad value for SchedDoneThreshold.  TAKO can run with the default value if that is desired.
Recovery: See tako.init description for valid values. Correct the tako.init file and restart TAKO.


	The value, Value, for Msg

where Value is the field value
Msg is the field name and validation error text
	warning
	Cause:  A CSV import record contains an invalid value for a field.  This record is skipped and the other records in the file are be processed.

Recovery:  Correct the CSV file you were importing. Refer to the CSV file format. Import the file again.



	Timeline cannot be transferred. Installation or data file error. Save the log file and get help.

  
	error
	Cause: Serious problem with configuration or the file system.

Recovery: Save the TAKO log file so that the problem can be diagnosed.  



	Timeline is not approved. PPSTfile failed to be merged with the Master PPST.  

where PPSTfile is the PPST file name
	error
	Cause:  See the terminal window for detailed on why the merge operation failed.  It could be because the PPST or Master PPST files can't be accessed because someone did something like delete files that shouldn't have been or changed read or write permissions on the directory.

Recovery:  Fix any file system problems.



	Timeline transfer failed: Status

where Status is an error message


	error
	Cause: File transfer to the MOC failed. The message contains the details.

Recovery: Correct the described problem.  To reattempt the file transfer, select the Retransfer PPST  menu option.



	Timeline was not approved because the PPST has not been generated. 
	info
	Cause: User selected Approve PPST menu option without having generated the PPST or after deleting it.



	Timeline was not approved because the schedule was changed. 
	
	Cause: Changes were made to the schedule or observations after the PPST was created.

Recovery:  If you wanted to approve the current PPST, then reload the unmodified Alternate target DB file then Approve the PPST.  If you wanted to approve the current schedule, then you would need to save the target DB under a new name, then generate and approve the PPST.  



	Warning--  unknown type Type of constraint found for key Key!

where Type is a constraint type

Key is the constraint name
	warning
	Cause: invalid constraint type.  This is probably a software error, since constraints are validated by editor.  Submit a software anomaly report and attach the Tako log file.

Recovery: Delete the constraint definition that contains the unknown type.


	Warning, some constraints still unresolved, proceeding anyway
	warning
	Caused: when resolving derived constraints that are nested more than 10 deep.  e.g.,  A derived from B derived from C, etc

Recovery: Do not define derived constraints that would make a "chain" of references to other derived constraints that result in a nesting of more than 10 definitions.  



E. GLOSSARY
goodtime 1) when applied to scheduling a target.  It refers to the time blocks during which none of the observing constraints are violated.

2) in defining constraints, it is a resource that is debited when the constraint is violated.

MJD is the acronym for Modified Julian Date.

Modified Julian Date is a time and date format was introduced by space scientists in the late 1950's.  The Modified Julian Date gives the number of days since midnight on November 17, 1858. This date corresponds to 2400000.5 days after day 0 of the Julian calendar, hence it is called Modified Julian Date. The time of day is represented as a fraction of a day.

observation is used in this document as a shorten form of observation segment

observation list (also called "target list") is the current set of observation segment definitions. 

observation segment definition contains parameters that define observation segment: the target location, spacecraft roll angle, and instrument modes.  A target may have several observation segments defined for it.

POW is the software component that implements the timeline plots. 

snapshot is a portion of an observation segment that can be made while observation constraints are not violated.

target is a location in the sky given as right ascension and declination.  
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